




Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©September 2008

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. pat-
ents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home
or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineer-
ing or disassembly is prohibited.

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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Preface
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
II



Preface
IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range 220W AC/DC Adapter – AC Input 

100 - 240V, 50 - 60Hz DC Output 20V, 11A).

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELE-
COMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
III
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place where 
foreign matter or moisture may 
affect the system.

Don’t use or store the computer 
in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
IV
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power until 
you properly shut down all pro-
grams.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
V
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, 

uninterrupted power supply. If you are unsure of your local power specifications, consult 
your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong 
is an important safety feature; do not defeat its purpose. If you do not have access to a 
compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VI
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
VII
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. Do not use volatile (petroleum distillates)
or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
VIII
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
IX
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
X
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
XI
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Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.

Cable TV Safety
If you have included a TV Tuner in your purchase option then pay careful attention to the following:

• Make sure that your CATV system installer has connected the Coaxial cable shield to the grounding system of the 
building, as close to the point of cable entry as practical.

• This reminder is provided to call the CATV system installer’s attention to Article 820-93 of the NEC (Section 54, Part 
I of the Canadian Electrical Code).

• The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner 
module outdoors.
XII



Preface
Contents
Notice ................................................................................. I

FCC Statement .............................................................II
Instructions for Care and Operation .......................... IV
Power Safety ..............................................................VI
Battery Precautions ...................................................VII
Cleaning .................................................................. VIII
Servicing ................................................................. VIII
Travel Considerations ................................................ IX

Quick Start Guide
Overview ........................................................................1-1

Advanced Users ...........................................................1-2
Beginners and Not-So-Advanced Users ......................1-2
Warning Boxes ............................................................1-2
Not Included ................................................................1-3
System Software ..........................................................1-4

System Startup ...............................................................1-5
System Map: LCD Panel Open ......................................1-6

LED Indicators ............................................................1-7
Hot Key Buttons & Keyboard .......................................1-8
System Map: Front & Rear Views ...............................1-10
System Map: Left View ...............................................1-11
System Map: Right & Bottom Views ..........................1-13

Windows Vista Start Menu & Control Panel ...............1-14
Video Features .............................................................1-15

Display Devices & Options .......................................1-16
Power Options ..............................................................1-17

Storage Devices, Mouse, Audio & 
Printer
Overview ........................................................................2-1
Hard Disk Drive .............................................................2-2
Optical Device ...............................................................2-3

Loading Discs ..............................................................2-3
Handling CDs or DVDs ...............................................2-4
DVD Regional Codes ..................................................2-5

7-in-1 Card Reader .........................................................2-6
ExpressCard Slot ............................................................2-7

Inserting and Removing ExpressCards ........................2-7
Application Hot Key ......................................................2-8
Game Keys .....................................................................2-9
TouchPad and Buttons/Mouse .....................................2-10
Audio Features .............................................................2-11
Adding a Printer ...........................................................2-12

USB Printer ................................................................2-12
Install Instructions: ...................................................2-12
XIII



Preface
Parallel Printer ...........................................................2-12

Power Management
Overview ........................................................................3-1
The Power Sources ........................................................3-2

AC/DC Adapter ...........................................................3-2
Battery .........................................................................3-2

Turning on the Computer ...............................................3-3
Power Plans ...................................................................3-4
Power-Saving States ......................................................3-6

Sleep ...........................................................................3-6
Hibernate ....................................................................3-7
Shut Down ..................................................................3-7

Configuring the Power Buttons .....................................3-8
Resuming Operation ...................................................3-9

Battery Information .....................................................3-10
Battery Power ...........................................................3-10

Conserving Battery Power ...........................................3-11
Battery Life ..................................................................3-12

New Battery ..............................................................3-12
Recharging the Battery with the AC/DC Adapter .....3-12
Proper handling of the Battery Pack .........................3-13

Battery FAQ ..............................................................3-14

Drivers & Utilities
RAID & AHCI Setup ..................................................4-1

What to Install ................................................................4-1
Module Driver Installation ..........................................4-1

Driver Installation ..........................................................4-2
Manual Driver Installation .........................................4-3

Updating/Reinstalling Individual Drivers ...................4-4
User Account Control (Win Vista) ..............................4-4
Windows Security Message .........................................4-4
New Hardware Found ..................................................4-4
Driver Installation Procedure .......................................4-5
Video (VGA) ..............................................................4-5
Audio ..........................................................................4-5
Modem ........................................................................4-5
TouchPad ....................................................................4-5
Card Reader/ExpressCard ..........................................4-6
Ap-Key Utility ............................................................4-6

Optional Drivers ..........................................................4-6
Intel Matrix .................................................................4-7
Wireless LAN .............................................................4-7
Bluetooth ....................................................................4-7
PC Camera ..................................................................4-7
TV Tuner ....................................................................4-7
XIV



Preface
BIOS Utilities
Overview ........................................................................5-1
The Power-On Self Test (POST) ...................................5-2

Failing the POST .........................................................5-3
Fatal Errors .................................................................5-3
Non-Fatal Errors .........................................................5-3

The Setup Program ........................................................5-4
Entering Setup .............................................................5-4
Setup Screens ...............................................................5-5

Main Menu .....................................................................5-6
System Time & Date (Main Menu) ...............................5-6
SATA Port 1/2/3: (Main Menu) ....................................5-7
IDE Channel 0 (Main Menu) .........................................5-7
Installed Memory: (Main Menu) ...................................5-7
Advanced Menu .............................................................5-8
SATA Mode: (Advanced Menu) ...................................5-8
Reset Configuration Data: (Advanced Menu) ...............5-9
Security Menu ..............................................................5-10
Set Supervisor Password (Security Menu) ..................5-10
Password on boot: (Security Menu) ............................5-11
Boot Menu ...................................................................5-12
Exit Menu ....................................................................5-13

Upgrading The Computer
Overview ........................................................................6-1

When Not to Upgrade ..................................................6-2
Removing the Battery ....................................................6-3
Upgrading the Hard Disk Drive(s) .................................6-4
Upgrading the System Memory (RAM) ........................6-7
Upgrading the Optical (CD/DVD) Device(s) ..............6-10
Upgrading the Video Card ...........................................6-11

Modules
Overview ........................................................................7-1
Setting Up SATA RAID or AHCI Modes .....................7-2

AHCI Mode ................................................................7-2
RAID ..........................................................................7-2
SATA RAID or AHCI Setup Procedure (BIOS) ........7-4
RAID Setup (Intel Matrix) .........................................7-5

Intel Matrix ..................................................................7-7
Intel Matrix Driver Installation ..................................7-7

Wireless LAN Module ...................................................7-8
Intel WLAN Driver Installation .................................7-8

Connecting to a Wireless Network ..............................7-9
Bluetooth Module ........................................................7-12

Bluetooth Driver Installation ....................................7-12
PC Camera Module ......................................................7-16

PC Camera Driver Application ................................7-17
PC Camera Audio Setup ...........................................7-18

BisonCap ...................................................................7-20
XV



Preface
Eliminating Screen Flicker (BisonCap) ....................7-21
Video View ................................................................7-22

Mini-PCI TV Tuner Module ........................................7-25
MPC788/MPC718 Driver & Software .....................7-26
Digital TV Broadcast Signal ....................................7-28
TV Recording and Power Plans ...............................7-28
Remote Control Unit ................................................7-28

Troubleshooting
Overview ........................................................................8-1
Basic Hints and Tips ......................................................8-2
Backup and General Maintenance .................................8-3
Viruses ...........................................................................8-4
Upgrading and Adding New Hardware/Software ..........8-5
Problems & Possible Solutions ......................................8-7

Interface (Ports & Jacks)
Overview .......................................................................A-1
Ports and Jacks .............................................................. A-2
Card Reader .................................................................. A-2
Cable (CATV) .............................................................. A-2
Antenna Jack ................................................................. A-2
DC-In Jack .................................................................... A-2
DVI-Out Port ................................................................A-2
External Monitor Port ...................................................A-2

Headphone-Out Jack .....................................................A-3
Line-In Jack ..................................................................A-3
Microphone-In Jack ......................................................A-3
Mini-IEEE 1394 Port ....................................................A-3
RJ-11 Phone Jack ..........................................................A-3
RJ-45 LAN Jack ............................................................A-4
S/PDIF-Out Jack ...........................................................A-4
Security Lock Slot ........................................................A-4
S-Video-In Jack ............................................................A-4
S-Video-Out Jack ..........................................................A-4
USB 2.0/1.1 Ports .........................................................A-4

NVIDIA Video Driver Controls
NVIDIA Video Driver Installation ............................... B-1
NVIDIA Control Panel ................................................. B-2
SLI Multi GPU Configuration ...................................... B-5
SLI Multi GPU Configuration & Battery Power .......... B-6
Display Devices ............................................................ B-7
Attaching Other Displays .............................................. B-8
Display Modes ............................................................ B-10
Enabling TV Display .................................................. B-13

Changing the TV Signal Format ............................... B-14

Specifications
Processor Types ............................................................ C-2
XVI



Preface
Core Logic .................................................................... C-2
LCD .............................................................................. C-3
Security ......................................................................... C-3
Memory ......................................................................... C-3
BIOS ............................................................................. C-3
Video Card Options ...................................................... C-4
Storage Options ............................................................ C-5
Audio ............................................................................ C-5
Keyboard & Pointing Device ........................................ C-5
I/O Ports ........................................................................ C-6
Communication ............................................................. C-6
Operating Systems Supported ....................................... C-6
Power Management ...................................................... C-7
Power ............................................................................ C-7
Environmental Spec ...................................................... C-7
Physical Dimensions & Weight .................................... C-7
Optional ........................................................................ C-8

Windows XP Information
DVD Regional Codes ...................................................D-2
Audio Features .............................................................. D-4
Application Hot Key ..................................................... D-5
Game Keys .................................................................... D-6
Video Features .............................................................. D-7
Display Properties .........................................................D-8

Display Devices & Options ...........................................D-9
SLI Multi GPU Configuration ....................................D-10
Attaching Other Displays ............................................D-12
To Enable Windows Extended Desktop ......................D-14
Enabling TV Display ..................................................D-15
Changing the TV Signal Format..................................D-16
Power Management Features ......................................D-17
Power Schemes ...........................................................D-17
System Power Options.................................................D-18
Hibernate Mode vs. Shutdown ....................................D-18
Stand by Mode vs. Hibernate Mode ............................D-18
Stand by ......................................................................D-19
Hibernate .....................................................................D-19
Configuring the Power Button ....................................D-20
Battery Information .....................................................D-21
New Battery ................................................................D-21
Battery Life .................................................................D-21
Recharging the Battery with the AC/DC Adapter .......D-22
Proper handling of the Battery Pack ...........................D-23
Battery FAQ.................................................................D-24
Driver Installation .......................................................D-25
What to Install .............................................................D-26
Updating/Reinstalling Individual Drivers ...................D-27
Chipset ........................................................................D-28
Video ...........................................................................D-28
XVII



Preface
Audio ..........................................................................D-28
Modem ........................................................................D-28
LAN ............................................................................D-28
TouchPad ....................................................................D-29
Card Reader/ExpressCard ...........................................D-29
Ap-Key Utility ............................................................D-29
Module Drivers............................................................D-29
Setting Up SATA RAID or AHCI Modes ..................D-30

AHCI Mode .............................................................D-30
RAID .......................................................................D-30

SATA RAID or AHCI Setup Procedure (BIOS) ........D-32
RAID Setup (Intel Matrix) ..........................................D-33
Windows Setup for RAID & AHCI Modes ................D-35
Intel Matrix Driver Installation ...................................D-36
Intel WLAN Module ...................................................D-37
Intel WLAN Driver Installation ..................................D-37
Bluetooth Module .......................................................D-39
Bluetooth Driver Installation ......................................D-39
PC Camera Module .....................................................D-43
PC Camera Driver Installation ....................................D-44
PC Camera Audio Setup .............................................D-45
BisonCap......................................................................D-47
Eliminating Screen Flicker (BisonCap) ......................D-48
Video View..................................................................D-49
Eliminating Screen Flicker (Video View) ..................D-50

Mini-PCI TV Tuner Module .......................................D-52
MPC788/MPC718 Driver & 
Cyberlink PowerCinema Installation ..........................D-52
XVIII



Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Audio Features, 
& Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Wireless LAN, Bluetooth, PC Camera, TV Tuner and RAID 

modules (some of which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the NVIDIA Video driver controls.
• Appendix C The computer’s specification.
• Appendix D Information on the Window’s XP OS.
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer”
on page 6 - 1 in the remainder of the User’s Manual. You may also find the notes marked with a  of interest
to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
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Not Included
Operating Systems (e.g. Windows Vista/ Windows XP etc.) and applications (e.g. word processing, spreadsheet
and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.
Overview 1 - 3
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System Software
Your computer may already come with system software pre-installed. Where this is
not the case, or where you are re-configuring your computer for a different system,
you will find the following operating systems are supported:

Table 1 - 1 - Operating Systems Supported

*Note: For information on the Windows XP OS (specifically power, video and driver
information) see “Windows XP Information” on page D - 1.

Operating System & Version Note

*Windows XP (Home or Professional)

*Windows XP Media Center Edition

Windows Vista (64-bit) Home Basic Edition In order to run Windows Vista
without limitations or decreased
performance, your computer requires
a minimum 1GB of system memory
(RAM).

Windows Vista (64-bit) Home Premium Edition

Windows Vista (64-bit)
Business/Enterprise/Ultimate Editions

TV Tuner Module 
Support

Note that the TV Tuner
module (factory) options
in Windows Vista are
supported by the Win-
dows Media Center
software which comes
built-in to the Windows
Vista Home Premium
and Ultimate Editions
only. 

If your purchase in-
cludes a TV Tuner op-
tion, and you are re-
configuring your system
for a different system,
you should install either
Windows Home Premi-
um or Ultimate Edi-
tions only.
1 - 4 Overview
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
5. Move the LCD latches at the front of the computer outwards towards the sides of the computer, and hold them 

in place while raising the top cover.
6. Raise the lid/LCD to a comfortable viewing angle, and press the power button to turn the computer “on”.
7. Adjust the LCD panel to a comfortable viewing angle.
8. The LED indicators show the power and battery status of the computer and display information on the power 

status of the Bluetooth and Wireless LAN modules.

Figure 1 - 1 - Computer With AC/DC Adapter Plugged In

Shutdown

Note that you should always shut your computer down by
choosing the Shut Down command from the Lock Button
Menu in Windows Vista. This will help prevent hard disk or
system problems.
System Startup 1 - 5
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System Map: LCD Panel Open

Figure 1 - 2 - LCD Panel Open

1. Optional Built-In 
PC Camera

2. LCD
3. LED Power & 

Communication 
Indicators

4. Built-In 
Microphone

5. LED Status 
Indicators

6. Hot Key Buttons
7. Power Button
8. Keyboard
9. Speakers
10. Game Hot Keys
11. Touchpad & 

Buttons

2

1

6

9
7

4
3

Wireless Device Operation 
Aboard Aircraft

The use of any portable electronic
transmission devices (e.g. WLAN or
Bluetooth) aboard aircraft is usually
prohibited. Make sure any wireless
modules are OFF if you are using the
computer aboard aircraft.

Use the appropriate function key com-
bination (see Table 1 - 5, on page 1 -
9) to toggle power to any wireless mod-
ules, and check the LED indicators to
see if any modules are powered on or
not (see Table 1 - 3, on page 1 - 7).

9

11

5

8
10

3

1 - 6 System Map: LCD Panel Open
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LED Indicators
The two sets of LED indicators (LED Status Indica-
tors and LED Power & Communication Indicators)
on the computer display helpful information about the
current status of the computer.

Table 1 - 2 - LED Status Indicators

Table 1 - 3 - LED Power & Communication Indicators

Icon Color Description

Green Card Reader Activity

Green Hard Disk Activity

Green Number Lock Activated

Green Caps Lock Activated

Green Scroll Lock Activated (to activate 
press Fn & Scr Lk)

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green The Computer is in Sleep 
Mode

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange The Battery Has Reached 
Critically Low Power Status

Green The (optional) Wireless LAN 
Module is powered On

Orange The (optional) Bluetooth 
Module is powered On
System Map: LCD Panel Open 1 - 7
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Hot Key Buttons & Keyboard
These buttons give instant access to the default Inter-
net browser and e-mail program, and to a user-defined
application, with one quick button press. To use the
“user-defined application Hot Key Button”, you must
install the driver. See “Application Hot Key” on
page 2 - 8 for configuration instructions.

Table 1 - 4 - Hot Key Buttons

In addition to the Hot Keys outlined above, the two
Game Keys on the left of the computer allow macros
to be configured for common keystrokes used in appli-
cations, as long as the driver is installed (see “Game
Keys” on page 2 - 9).

The keyboard has a numerical keypad for easy numer-
ic data input, and features Function Keys to allow you
to change operational features instantly.

Activate the Number Lock feature by pressing the
Num Lk key at the top right of the keyboard. You may
check if Number Lock is enabled or not by looking at
the LED status indicators.

Hot Key Function

Activate the Default E-Mail Browser

 Activate the Default Internet Program

Activate the user specified application e.g. 
Microsoft Word or Excel

Other Keyboards

If your keyboard is damaged or you just want to make
a change, you can use any standard USB keyboard.
The system will detect and enable it automatically.
However special functions/AP-Key buttons unique to
the system’s regular keyboard may not work.
1 - 8 Hot Key Buttons & Keyboard
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Table 1 - 5 - Function Keys

Figure 1 - 3 - Keyboard

Keys Description Keys Description

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F7 Display Toggle

Fn + F1 TouchPad Toggle Fn + F8 Decrease LCD Brightness

Fn + 1 Fan Automatic Control / Full Power Fn + F9 Increase LCD Brightness

Fn + F3 Mute Toggle Fn + F10 PC Camera Toggle

Fn + F4  Sleep Toggle Fn + F11 WLAN Module Toggle

Fn + F5 Decrease Audio Volume Fn + F12 Bluetooth Module Toggle

Fn + F6 Increase Audio Volume Fn + Scr Lk Scroll Lock Toggle

Special Characters

Some software applications allow the number-keys
to be used with Alt to produce special characters.
These special characters can only be produced by
using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make
sure that Num Lk is on.

Fn Key

Function Keys

Numeric 
KeypadNum Lk & Scr Lk Keys
Hot Key Buttons & Keyboard 1 - 9
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System Map: Front & Rear Views

Figure 1 - 4 - Front & Rear Views

1. LCD Latches
2. Line-In Jack
3. S/PDIF-Out Jack
4. Microphone-In 

Jack
5. Headphone-Out 

Jack
6. Speakers
7. Vent/Fan Intake
8. DC-In Jack
9. DVI-Out Port 
10. S-Video-In Jack*

*Enabled with Optional
Mini-PCI TV Tuner Only

1

2

1

Overheating

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s)
while the computer is in use.

5

7 8 9

6
3

10

4
6

7

1 - 10 System Map: Front & Rear Views
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System Map: Left View

Figure 1 - 5 - Left View

1. External Monitor 
Port

2. S-Video-Out Jack*
3. Cable (CATV) 

Antenna Jack**
4. RJ-11 Phone Jack
5. RJ-45 LAN Jack
6. Mini-IEEE 1394 

Port
7. Express Card Slot
8. Optical Device 

Drive Bay (for CD/
DVD Device)

9. 7-in-1 Card 
Reader

*The S-Video-Out Jack is
not supported by the
NVIDIA GeForce 9800M
GT or NVIDIA GeForce
9800M GTX Video Cards

**Enabled with Optional
Mini-PCI TV Tuner Only

31 52 4 6 7
8

9

Mini-IEEE 1394 Port

The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.

ExpressCard Slot

The ExpressCard Slot accepts either ExpressCard/34 or ExpressCard/54 formats.

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / 
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) / 

Mini SD (requires PC adapter) / RS MMC (requires PC adapter)
System Map: Left View 1 - 11
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Disk Eject Warning

Don’t try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don’t try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
1 - 12 System Map: Left View
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System Map: Right & Bottom Views

Figure 1 - 6 - Right & Bottom Views

1. USB Ports
2. Security Lock 

Slot
3. Battery 

(Secondary HDD 
Bay - HDD3)

4. Fan Outlet/Intake
5. Primary HDD 

Bay (HDD1 & 
HDD2)

6. Component Bay 
Cover

Battery Information

Always completely discharge,
then fully charge, a new battery
before using it. Completely dis-
charge and charge the battery
at least once every 30 days or
after about 20 partial discharg-
es. See “Battery Informa-
tion” on page 3 - 10 for
full instructions.

1 1
2

3

4 4 4 4

5

6

Overheating

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan in-
take(s) while the computer is in use.
System Map: Right & Bottom Views 1 - 13
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle off Category View.

Figure 1 - 7 - Start Menu & Control Panel

Click here to toggle Category View

 

1 - 14 Windows Vista Start Menu & Control Panel
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Video Features
You can configure display options, from the Display Settings control panel in Windows as long as the appro-
priate video driver is installed. For more detailed video information see “NVIDIA Video Driver Controls” on
page B - 1. To access Display Settings in Windows:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click 

Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 1 - 8 on page 1 - 16).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 8 on page 1 - 16).
5. Click Advanced Settings (button)  (Figure 1 - 8 on page 1 - 16).
6. Click GeForce..... (tab).
7. Click Start the NVIDIA Control Panel  (Figure 1 - 8 on page 1 - 16) to access the control panel.
8. The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA 

Control Panel.

1
2

3

4

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. This computer features an
NVIDIA Scalable Link Interface (SLI) that improves graphic quality and performance by combining dual NVIDIA GPUs
in a single system for some of the video card options. SLI Configuration needs to be enabled from the NVIDIA Control
Panel (3D Settings > Set SLI Configuration); see “SLI Multi GPU Configuration” on page B - 5. Check with your ser-
vice center for the latest details on video cards supported (see “Video Card Options” on page C - 4 for details). SLI Con-
figuration should not be enabled under battery power (see page B - 6).
Video Features 1 - 15
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Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display (con-
nected to the DVI-Out port) or TV (connected to the S-Video-Out jack if supported by your video card) as your
display device.

Figure 1 - 8 - Display Settings & NVIDIA Control Panel

Table 1 - 6 - Display Modes Available

NVIDIA Display Mode Description Note

Single One display device is used. Note that SLI 
configuration 
supports only 
Single display.

Clone Both connected displays output the same view

Dualview Both connected displays are treated as separate devices, and act as a virtual desktop

1 2

3

4

1 - 16 Video Features
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 14) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

Figure 1 - 9 - Power Options

Note: Sleep is the default power saving state in Windows Vista
Power Options 1 - 17
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Chapter 2: Storage Devices, Mouse, Audio & 
Printer
Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical Device
• 7-in-1 Card Reader
• ExpressCard Slot
• Application Hot Key
• Game Keys
• TouchPad and Buttons/Mouse
• Audio Features
• Adding a Printer
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive(s) is(are) used to store your data in the computer. The hard
disk(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives
with a height of 9.5 mm. The primary hard disk bay  is accessible from the bottom
of your computer as seen below, and the secondary hard disk bay  is located under
the battery compartment.

The computer can accommodate up to three hard disks (two in the primary bay, and
one in the secondary bay), and these may be configured in RAID or AHCI modes.

Further details on removing and inserting the hard disk are available in “Upgrading
the Hard Disk Drive(s)” on page 6 - 4.

Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

 Figure 2 - 1
Hard Disk Bays

1
2

1

2

2 - 2 Hard Disk Drive
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Optical Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the model you purchased (see “Storage Options” on page C -
5). The optical device is usually labeled “Drive D:” and may be used as a boot de-
vice if properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting. 

Peripherals must be
connected before you
turn on the system.

 Figure 2 - 2
Optical Device

1

2

3

12 3
Optical Device 2 - 3
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 Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 12.
.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4 South & Central America, Mexico, 
Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding

 Figure 2 - 3
DVD Regions
Optical Device 2 - 5
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 7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “Card Reader/ExpressCard” on page 4 - 6).

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

 Figure 2 - 4
Left View

1. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS (Memory Stick Pro)

• MS Duo (requires PC adapter*)
• Mini SD (requires PC adapter*)
• RS MMC (requires PC adapter*)

1

2 - 6 7-in-1 Card Reader
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34. Make sure you install the Express-
Card driver (see “Card Reader/ExpressCard” on page 4 - 6).

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place.
• To remove an ExpressCard, simply press the card to eject it (as pictured in the 

generic figure below).

ExpressCard 
Slot Cover

Make sure you keep the
cover in the Express-
Card slot when not in
use. This will help pre-
vent foreign objects and/
or dust getting in to the
ExpressCard Slot.

 Figure 2 - 5
Express Card Slot
ExpressCard Slot 2 - 7
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 Application Hot Key
The hot key buttons give instant access to the default Internet browser and e-mail
program, and to a user-defined application, with one quick button press. To config-
ure a program to open when the application hot key  is pressed (Windows Media
Player is the default program), follow the instructions below (make sure you have
installed the Ap-Key Utility driver - see “Ap-Key Utility” on page 4 - 6).

1. Right click the Hot Key driver icon  in the taskbar.
2. Select Setup from the menu and then select Application 1.

3. An Open dialog box will appear on the screen.

4. Click Look in: and browse to the directory where the desired application.exe (see 
the sidebar) program exists.

5. Double-Click on the program file or choose Open.

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut. To
find the application right-
click its shortcut on the
desktop and click Prop-
erties. Click the short-
cut (tab) and see where
the executable file is lo-
cated by clicking the
Open File Location
(button).

 Figure 2 - 6
Application Hot Key 

Configuration
2 - 8 Application Hot Key
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Game Keys
The two game hot keys on the left of the computer allow macros to be configured
for common keystrokes used in applications (the keys can assigned macros for any
program, not only games). To configure the keys follow the instructions below
(make sure you have installed the Ap-Key Utility driver - see “Ap-Key Utility” on
page 4 - 6).

1. Run the Game Key Configuration program from the desktop icon  (or from 
C:\Windows\CleGameKey\GmKeyCfgUtl.exe).

2. Double-click the button  for the appropriate key (it will turn red ).
3. When the button is red  you may then record the keystrokes to be assigned to 

the Game Key.

4. Click OK.
5. Repeat the procedure for the other Game Key if required.
6. Close the Game Key Configuration window.
7. The keystroke order will be repeated with the appropriate button press in any 

application program.

Figure 2 - 7
Game Key 

Configuration
Game Keys 2 - 9
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 TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. The central button may be configured to
function as you require.

Install the TouchPad driver (see page 4 - 5) and then double-click the TouchPad
driver icon  in the taskbar to configure the functions. You may then configure the
TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your
preferences. The TouchPad may be toggled on/off by means of the Fn + F1 key
combination.

Mouse Driver

If you are using an exter-
nal mouse your operat-
ing system may be able
to auto-configure your
mouse during its instal-
lation or only enable its
basic functions. Be sure
to check the device’s
user documentation for
details.

 Figure 2 - 8
Mouse Properties
2 - 10 TouchPad and Buttons/Mouse
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Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar/
control panel (right-click the taskbar icon  to bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination. 

Sound Volume 
Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 9
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.
Audio Features 2 - 11
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 Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar
(you will need to purchase a parallel to USB converter).

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
2 - 12 Adding a Printer
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system.

This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
Vista OS.)
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components (see page C - 7).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.
3 - 2 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut
Down hot key button when it is pressed for less than 4 seconds (pressing and holding
the power button for longer than this will force the computer to shut down). Use
Power Options (Hardware and Sound menu) control panel in Windows Vista to
configure this feature (see Figure 3 - 4 on page 3 - 8).

Shut Down

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vis-
ta. This will help prevent
hard disk or system
problems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).
Turning on the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
3 - 4 Power Plans
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Each Windows Power Plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans
Power Plans 3 - 5
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

Power Button

The Power Button 
in the Start Menu (in
Classic View use the
Shut Down button )
can be used to send the
computer into a power-
saving state.

Sleep Mode & 
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power. 

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.
3 - 6 Power-Saving States
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down
You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.

Figure 3 - 3
Lock Button Menu
Power-Saving States 3 - 7
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state.Password 

Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 
Operation

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
Configuring the Power Buttons 3 - 9
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
3 - 10 Battery Information
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.

Windows Mobility 
Center

The Windows Mobility
Center control panel pro-
vides an easy point of ac-
cess for information on
battery status, power plans
used and wireless device
status etc.

Figure 3 - 6
Windows Mobility 

Center
Conserving Battery Power 3 - 11
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 7 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)
3 - 12 Battery Life
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.
Battery Life 3 - 13
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power 

settings.

Figure 3 - 7
Power Plan Create
3 - 14 Battery Life
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 8
Power Options 

Advanced Settings - 
Battery
Battery Life 3 - 15
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI Configura-
tion, you should not enable SLI configuration if your computer is powered by battery
only. If you attempt to run an SLI configuration when the computer is powered by the bat-
tery only, then system problems may occur.

If the computer is currently powered by battery only do not enable SLI configuration. 

If you have currently enabled SLI configuration, and the computer is powered by the AC/
DC adapter, do not switch to battery power only (or go to the NVIDIA Control Panel and
disable SLI configuration before switching to battery power only).
3 - 16 Battery Life
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to
be done prior to installing the Windows OS, and there-
fore before installing the other drivers listed here (see
“Setting Up SATA RAID or AHCI Modes” on page 7
- 2).

What to Install
The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer. The disc contains
drivers for Windows Vista and Windows XP (the ap-
propriate drivers will autorun for your system).

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated (see “Driver Installa-
tion” on page D - 25 for Windows XP information).

Module Driver Installation
The procedures for installing drivers for the RAID,
WLAN, Bluetooth, PC Camera and TV Tuner mod-
ules are provided in “Modules” on page 7 - 1. Only in-
stall drivers for modules included in your purchase
option.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or click Op-
tional (button) to access the Optional driver menu.

If you wish to install the drivers manually see page 4 - 3.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

 
Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation
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Manual Driver Installation
To install the drivers manually click the Browse CD button in the Drivers Installer application and browse to the
executable file in the appropriate driver folder.

Table 4 - 1 - Driver Installation

Driver Page Notes

Video (VGA) Page 4 - 5

Note that setting up a RAID, or AHCI mode, 
needs to be done prior to installing the Win-
dows OS, and therefore before installing the 
other drivers listed here.

The optional TV Tuner drivers/applications are 
provided on a separate CD.

Audio Page 4 - 5

Modem Page 4 - 5

TouchPad Page 4 - 5

Card Reader/ExpressCard Page 4 - 6

Ap-Key Utility Page 4 - 6

Intel Matrix (RAID or AHCI) Page 7 - 7

Wireless LAN Module Page 7 - 8

Bluetooth Module Page 7 - 12

PC Camera Module Page 7 - 17
Driver Installation 4 - 3
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure (other than when outlined in the
driver install procedure), click Cancel to close the
window, and follow the installation procedure.
4 - 4 Driver Installation
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Driver Installation Procedure

Video (VGA)
1. Click 1.Install Video Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Audio
1. Click 2. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.
3. The modem is now ready for configuration.

TouchPad
1. Click 4.Install Touchpad Driver > Yes.
2. Click Next > Finish.
3. Click Restart Now to restart the computer.
4. You may then configure your TouchPad as out-

lined in “TouchPad and Buttons/Mouse” on 
page 2 - 10.

Modem Country Selection

Go to the Phone and Modem Options control panel
(Hardware and Sound) and make sure the modem
country selection is appropriate for you.
Driver Installation 4 - 5
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Card Reader/ExpressCard
1. Click 5.Install CardReader Driver > Yes.
2. Click Next.
3. Click the button to accept the license, and then 

click Next.
4. Click Finish.

Ap-Key Utility
1. Click 6.Install AP-key Utility > Yes.
2. Click Next.
3. Click Finish to restart the computer.
4. See “Application Hot Key” on page 2 - 8 and 

“Game Keys” on page 2 - 9 for configuration 
instructions.

Optional Drivers
See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

 
Figure 4 - 3 - Optional Drivers Installer Screen
4 - 6 Driver Installation
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Intel Matrix
This driver is only required if you have set up your
hard disks in RAID or AHCI modes (see “Setting Up
SATA RAID or AHCI Modes” on page 7 - 2).

Wireless LAN
See the appropriate install procedure for your WLAN
module in “Intel WLAN Driver Installation” on
page 7 - 8.

Bluetooth
See the install procedure in “Bluetooth Driver Instal-
lation” on page 7 - 12.

PC Camera
See the camera instructions in “PC Camera Driver
Application” on page 7 - 17.

TV Tuner
See the install procedure in “Mini-PCI TV Tuner
Module” on page 7 - 25.
Driver Installation 4 - 7
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

PhoenixBIOS Setup Utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in the PhoenixBIOS Setup Utility. Even if you are a begin-
ner, keep a record of the settings you find and any changes you make. This informa-
tion could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
Overview 5 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured is for guide-
line purposes only. 

Figure 5 - 1
POST Screen

Phoenix TrustedCore(tm) Desktop
Copyright 1985-2005 Phoenix Technologies Ltd.
All Rights Reserved
BIOS Revision: ******
KBC/EC Revision: ******

CPU = 1 Processor Detected, Cores per Processor = 2
Intel(R) Core(TM)2 CPU 6300 @ 1.86GHz
TCG is enabled
511M System RAM Passed
2048 KB L2 Cache
System BIOS shadowed
Video BIOS shadowed
Fixed Disk 0: TOSHIBA MK6034GSX
ATAPI CD-ROM: Optiarc DVD RW AD-7530A
Mouse intialized

Press <F2> to enter SETUP

1

2

3

4

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3



BIOS Utilities

5

The Setup Program
The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Entering Setup
To enter the PhoenixBIOS Setup Utility, turn on the computer and press F2 during
when you see the prompt "Press F2 to Enter Setup", which is usually present for a
few seconds after you turn on the system. If you get a “Keyboard Error”, (usually
because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
5 - 4 The Setup Program
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
The Setup Program 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu

Phoenix TrustedCore(tm) Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or
<Enter> selects field.

Main

System Time: [08:11:05]
System Date: [03/05/2007]

� SATA Port 1 [None]
� SATA Port 2 [60012MB SATA2]
� SATA Port 3 [None]

� IDE Channel 0 [CD-ROM]

  Installed memory 512 MB
  Available to OS 510 MB
  Used by devices 2 MB
5 - 6 Main Menu
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SATA Port 1/2/3: (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of hard disks on the
computer’s SATA ports. Use the Auto (Type:) setting to have the items configured
automatically for you.

IDE Channel 0 (Main Menu)
Pressing Enter here opens the sub-menu to show the configuration of the CD/DVD
device(s) on the computer’s IDE Channel. Use the Auto (Type:) setting to have the
items configured automatically for you.

Installed Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed (the items below will
show the memory used by devices and the memory available to the OS).
Main Menu 5 - 7
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Advanced Menu

SATA Mode: (Advanced Menu)
Press Enter here to open the sub-menu to choose the configuration of the SATA
mode. You may enable/disable SATA RAID or AHCI mode for your hard disks,
however you should only enable/disable SATA RAID or AHCI BEFORE in-
stalling an operating system, and after you have backed up all necessary files and
data (see sidebar).

RAID/AHCI 
Enable/Disable

Warning

DO NOT Enable/Dis-
able SATA RAID or
SATA AHCI unless you
intend to reinstall your
operating system. Make
sure you have backed
up all your data before
doing so.

Figure 5 - 3
Advanced Menu

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Setup Warning
Setting items on this menu to incorrect
values may cause your system to malfunction.

SATA Mode: [Normal]
Reset Configuration Data: [No]

Phoenix TrustedCore(tm) Setup Utility

Normal/RAID/AHCI Mode
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Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have in-
stalled a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.
Advanced Menu 5 - 9
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the PhoenixBIOS Setup Utility. This will not
affect access to the computer OS, (only the PhoenixBIOS Setup Utility).

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 4
Security Menu

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Supervisor Password
controls access to the
setup utility.

Security

Supervisor Password Is: Clear

Set Supervisor Password [Enter]

Password on boot: [Disabled]

Phoenix TrustedCore(tm) Setup Utility
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Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer. If “En-
abled” is selected, only users who enter a correct password can boot the system (see
the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Menu 5 - 11
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Boot Menu

When you turn the computer on it will look for an operating system from the devices
listed in this menu, and in this priority order. If it cannot find the operating system
on that device, it will try to load it from the next device in the order specified in the
Boot priority order. Item specific help on the right is available to help you move
devices up and down the order.

Figure 5 - 5
Boot Menu

Main Advanced Security Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or
configure devices:
Up and Down arrows
select a device.
<+> and <-> moves
the device up or down.
<f> and <r> specifies
the device fixed or
removable.
<x> exclude or include
the device to boot.
<Shift + 1> enables or
disables a device.
<1 - 4> Loads default
boot sequence.

Boot priority order:
1: USB FDC:
2: USB KEY:
3: PCI SCSI:
4: IDE HDD: TOSHIBA MK6034GSX-(S2)
5: IDE CD: Optiarc DVD RW AD-7530A-(S
6: PCI BEV: Relatek Boot Agent
7:
8:

Excluded from boot order:
: All IDE HDD:
: All IDE CDROM:
: All USB Floppy:
: All USB KEY:
: All USB HDD:
: USB CDROM:
: All USB CDROM:
: USB ZIP:

Boot

Phoenix TrustedCore(tm) Setup Utility

�
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 6
Exit MenuMain Advanced Security Boot

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Execute Command F10 Save and Exit

Item Specific Help

Exit System Setup and
save your changes to
CMOS.

Exit

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes

Phoenix TrustedCore(tm) Setup Utility
Exit Menu 5 - 13
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive(s)
• Upgrading the System Memory (RAM)
• Upgrading the Optical (CD/DVD) Device(s)
• Upgrading the Video Card
Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Power Safety Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1. Turn the computer off, and turn it over.
2. Loosen screws  - .
3. Release the battery, and lift the battery  out of the battery bay.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal

1 3
4

1

2

3

4
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Upgrading the Hard Disk Drive(s)
The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA)
hard disk drives with a height of 9.5mm (h) (see “Storage Options” on page C - 5).
Follow your operating system’s installation instructions, and install all necessary
drivers and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting
up a new hard disk.

Removing the Hard Disk(s) in the Primary HDD Bay
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  - .
3. Remove the bay cover .

HDD System Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 2
HDD Bay Cover 

Removal

1 4
5

1
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4

5
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4. Remove screws  -  and lift the hard disk assembly out of the computer.
5. Remove screws  - .
6. Separate the hard disk(s) from the bracket  and connector cable .
7. Insert the new hard disk into the computer.
8. Re-Insert the bracket and insert screws.

6 8
9 16

17 18

6

7

8
9

10

16
15

13
14

11 12
17

18

Figure 6 - 3
Primary HDD 

Removal
Upgrading the Hard Disk Drive(s) 6 - 5
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Removing the Hard Disk(s) in the Secondary HDD Bay
1. Turn off the computer, and turn it over and remove the battery.
2. The secondary hard disk bay is located under the battery compartment.
3. Remove screw .
4. Slide the hard disk assembly in the direction of the arrow .
5. Lift the hard disk assembly  out of the compartment.
6. Remove the screws to release the hard disk from the case.

Figure 6 - 4
Secondary HDD 

Removal
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-
DIMM) DDR II (DDR2) type memory modules (see “Memory” on page C - 3). The
total memory size is automatically detected by the POST routine once you turn on
your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component cover and remove screws  - .
3. Remove the bay cover .

Figure 6 - 5
Bay Cover Screws

1 10
11

1

3

2

45
7

6
89

10

11

RAM Fan
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4. Remove screws  -  from the RAM fan.

5. Remove the RAM fan .

12 14

12 14

13

Figure 6 - 6
RAM Fan Screws

Figure 6 - 7
RAM Fan Removal

15
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6. Gently pull the two release latches (  & ) on the sides of the memory socket in 
the direction indicated by the arrows in Figure 6 - 8

7. The RAM module  will pop-up, and you can remove it.

8. Pull the latches to release the second module if necessary.
9. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory socket.
10. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the socket as it will go. DO NOT FORCE the module; it should 
fit without much pressure.

11. Press the module in and down towards the mainboard until the socket levers click 
into place to secure the module.

12. Replace the RAM fan, cover and screws.
13. Restart the computer to allow the BIOS will register the new memory configuration 

as it starts up.

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 8
RAM Module 

Removal
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Upgrading the Optical (CD/DVD) Device(s)
1. Turn the computer off, turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  - .
3. Remove the bay cover .
4. Remove screw  and use the screwdriver to push the optical device(s) out of the 

computer at point .

Figure 6 - 9
Removing the CD/

DVD Device(s)
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6 - 10 Upgrading the Optical (CD/DVD) Device(s)
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Upgrading the Video Card
If you intend to upgrade or add another VGA card follow the procedures outlined
here. However please check with your service representative first to make sure your
computer can support more than one video card, and that you are not going to void
your warranty. Pay careful attention to the alignment of any video card into the slot
on the mainboard.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component cover and remove screws  - .
3. Remove the bay cover .

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

NVIDIA GeForce 
8800M GTX - SLI Card 

Installation

Please check with your
service representative
before installing two
NVIDIA GeForce
8800M GTX cards in an
SLI configuration.

Figure 6 - 10
Bay Cover Screws

1 10
11

1

3

2

45
7

6
89

10

11

Video Card Fans
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4. Remove screws  -  from the video card fan.
5. Disconnect the fan cable .

6. Remove the video card fan .

12 14
15

12

14

13

15

Figure 6 - 11
Video Card Fan 

Screws

Figure 6 - 12
Video Card Fan 

Removal
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7. Remove screws  -  from the video card heatsink in the order indicated on the 
label.

8. Remove screws  & .
9. Grip the handle and carefully remove the heatsink .

17 20

Caution

The heat sink, and video
card area in general,
contains parts which are
subject to high tempera-
tures. Allow the area
time to cool before re-
moving these parts.

Figure 6 - 13
Heatsink Removal
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10. Remove screw  from the video card.
11. Carefully remove the video card .

24

Figure 6 - 14
Video Card Removal

25

25

24
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Installing a New Video Card

1. Prepare to fit the video card into the slot by holding it at about a 30° angle.

2. The card needs to be fully into the slot, and the video card and socket have a 
guide-key and pin which align to allow the card to fit securely.

Contact Warning

Be careful not to touch
the metal pins on the
VGA card’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 15
Video Card 
Insertion
Upgrading the Video Card 6 - 15
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3. Fit the connectors firmly into the socket, straight and evenly.
4. DO NOT attempt to push one end of the card in ahead of the other.

5. The card’s pin alignment will allow it to only fit one way. Make sure the module is 
seated as far into the socket as it will go (none of the gold colored contact 
should be showing). DO NOT FORCE the card; it should fit without much 
pressure.

Figure 6 - 16
Video Card Insertion 

Procedure
6 - 16 Upgrading the Video Card
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6. Secure the card with screw  (Figure 6 - 14 on page 6 - 14).
7. Place the heatsink back on the card, and secure the screws in the order indicated 

in Figure 6 - 13 on page 6 - 13.
8. Attach the video card fan and secure with the screws as indicated in Figure 6 - 11 

on page 6 - 12.
9. Reinsert the component bay cover, and secure with the screws as indicated in 

Figure 6 - 10 on page 6 - 11.

24
Upgrading the Video Card 6 - 17
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Chapter 7: Modules
Overview
This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

• Setting Up SATA RAID or AHCI Modes
• Wireless LAN Module
• Bluetooth Module
• PC Camera Module
• Mini-PCI TV Tuner Module
Overview 7 - 1
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Setting Up SATA RAID or AHCI Modes
AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one, two or three hard disks.

RAID
You may use your hard disks (if you have included more than one hard disk in your
purchase option) in combination with Striping (RAID 0), Mirroring (RAID 1) or
Parity Across Disks (RAID 5) for either fault tolerance or performance (see Table 7
- 1, on page 7 - 3). To configure your system in Striping (RAID 0) or Mirroring
(RAID 1) modes you will require at least two hard disks; to configure your system
in Parity Across Disks (RAID 5) mode you will require three hard disks installed.
7 - 2 Setting Up SATA RAID or AHCI Modes
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Prepare the following before setting up your serial ATA hard disks in RAID mode
(to configure AHCI mode you do not need to prepare any extra hard disks but will
need to install the Intel Matrix driver):

1. The Microsoft Windows OS CD.
2. A second hard disk installed in the Primary HDD bay for RAID level 0 or 1 

(required for RAID but not required for AHCI).
OR
A a second hard disk installed in the Primary HDD bay, and a third hard disk in 
the Secondary HDD bay for RAID level 5.

3. The Device Drivers & Utilities + User’s Manual disc.

RAID Level Description

RAID 0
Identical drives reading and writing data in parallel to increase performance. RAID 0 
implements a striped disk array and the data is broken into blocks and each block is 
written to a separate disk drive.

RAID 1

Identical drives in a mirrored configuration used to protect data. Should a drive that is 
part of a mirrored array fail, the mirrored drive (which contains identical data) will 
handle all the data. When a new replacement drive is installed, data to the new drive is 
rebuilt from the mirrored drive to restore fault tolerance.

RAID 5
Identical drives (at least three drives must be used) in a parity across disks 
configuration are used to protect data and increase performance. A RAID 5 array 
can withstand a single disk failure without losing access to data.

Array Types

A Mirrored Array
(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
for any failed disk.

A Striped Array
(RAID 0) is NOT fault-
tolerant. The failure of
one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the I/O load
across the channels
and drives.

Table 7 - 1
RAID Levels
Setting Up SATA RAID or AHCI Modes 7 - 3



Modules

7

SATA RAID or AHCI Setup Procedure (BIOS)
1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "SATA Mode" and press Enter.

• For RAID Mode: - Set "SATA Mode" (“SATA Mode: (Advanced Menu)” on 
page 5 - 8) to "RAID".

                                   OR
• For AHCI Mode: - Set "SATA AHCI Enable" (“SATA Mode: (Advanced 

Menu)” on page 5 - 8) to "AHCI".

3. Press Esc and go to the Boot menu.
4. Set the CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is

inserted) as the first device in the boot order from the Boot menu.
5. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and

press Enter to exit the BIOS and reboot the computer.
6. For RAID mode see the instructions in “RAID Setup (Intel Matrix)” on page 7 - 5.
7. For AHCI mode simply install the Intel Matrix driver (see “Intel Matrix Driver

Installation” on page 7 - 7).
7 - 4 Setting Up SATA RAID or AHCI Modes
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RAID Setup (Intel Matrix)
1. Press Ctrl + i to enter RAID configuration menu.

2. Select 1.Create RAID Volume and press Enter.
3. Type the RAID volume name and then press Tab or Enter to advance to the next 

field.
4. Specify (use the up and down arrow keys) the RAID level (RAID 0 or RAID 1 or 

RAID 5 - see Table 7 - 1, on page 7 - 3) and then press Tab or Enter to advance to 
the next field.

5. Press Enter and the system will select the physical disks to use.
6. Press Enter and select (if applicable) the Strip Size (best set to default).
7. Press Enter and select the Capacity size (best set to default).
8. Press Enter to select Create Volume.
9. Press Enter to create the volume, and confirm the selection by pressing Y.

1. Create RAID Volume
2. Delete RAID Volume
3. Reset Disks to Non-RAID
4. Exit

RAID Volumes:
None Defined

Physical Disks:
Port Drive Model Serial # Size Type/Status(Vol ID)
0 FUJITSU MHV2040B NW56T5C25FAF 93.2GB Non-RAID Disk
1 FUJITSU MHT2060B NR0UT52256W7 55.9GB Non-RAID Disk

Intel(R) Matrix Storage Manager option ROM v6.1.0.1002 ICH8R wRAID5
Copyright (C) 2003-06 Intel Corporation. All Rights Reserved.

[ MAIN MENU ]

[ DISK/VOLUME INFORMATION ]

[��]-Select [ESC]-Exit [ENTER]-Select Menu

Figure 7 - 1
Intel(R) Matrix 

Storage Manager
Setting Up SATA RAID or AHCI Modes 7 - 5
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10. This will now return to the main menu.

11. Select 4.Exit and press Enter, then press Y to exit the RAID configuration menu.
12. As the computer starts up, press a key when you see the message "Press any 

key to boot from CD".
13. Press Enter to continue installing the operating system as normal (see your 

Windows documentation if you need help on installing the Windows OS).
14. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual 

disc as per Table 4 - 1, on page 4 - 3 (make sure you install the Intel Matrix driver 
- see “Intel Matrix Driver Installation” on page 7 - 7).

Figure 7 - 2
RAID Created 1. Create RAID Volume

2. Delete RAID Volume
3. Reset Disks to Non-RAID
4. Exit

RAID Volumes:
ID Name Level Strip Size Status Bootable
0 My RAID RAID1(Mirror) N/A 55.9GB Normal Yes

Physical Disks:
Port Drive Model Serial # Size Type/Status(Vol ID)
0 FUJITSU MHV2040B NW56T5C25FAF 93.2GB Member Disk(0)
1 FUJITSU MHT2060B NR0UT52256W7 55.9GB Member Disk(0)

Intel(R) Matrix Storage Manager option ROM v6.0.0.1022 ICH8R wRAID5
Copyright (C) 2003-06 Intel Corporation. All Rights Reserved.

[ MAIN MENU ]

[ DISK/VOLUME INFORMATION ]

[��]-Select [ESC]-Exit [ENTER]-Select Menu
7 - 6 Setting Up SATA RAID or AHCI Modes
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Intel Matrix
Make sure you install the Intel matrix driver and application if you have set up your
hard disk(s) in AHCI or RAID modes.

Intel Matrix Driver Installation
1. Click 1.Install Intel Matrix > Yes.
2. Click Next > Next > Yes > Next.
3. Click Finish to restart the computer.

The Intel Matrix Storage Console displays status information on your RAID con-
figuration. Run the Intel Matrix Storage Console from the Programs/All Programs
menu. The Intel(R) Matrix Storage Manager provides information on the RAID
status.

Figure 7 - 3
Intel Matrix Storage 

Console
Setting Up SATA RAID or AHCI Modes 7 - 7
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Wireless LAN Module
If you have included an Intel PRO/Wireless 3945ABG (802.11a/b/g) or Intel
PRO/Wireless 4965AGN (802.11a/g/n) PCIe WLAN module, make sure that the
Wireless LAN module is on before installing the driver. Use the Fn + F11 key com-
bination (see Table 1 - 5, on page 1 - 9) to toggle power to the Wireless LAN
module (when the WLAN module is on, the  LED will be green). Make sure
you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Intel WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual disc into the CD/DVD drive. 
2. Click Optional, and then click 2.Install Intel WLan driver > Yes.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows Vista (see overleaf).

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Use the Fn + F11 key
combination to toggle
power to the WLAN
module, and check the
indicator to see if the
module is powered on or
not (see Table 1 - 5, on
page 1 - 9).
7 - 8 Wireless LAN Module
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Connecting to a Wireless Network
1. Click the taskbar wireless icon , and then click Connect to a network (or right-

click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

Figure 7 - 4
Taskbar Menus

Network and 
Sharing Center

You can also use the
Network and Sharing
Center control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 5
Connect to a 

Network

Click icon Right-click icon
Wireless LAN Module 7 - 9
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4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or 

network (a list of options will appear allowing manual searching, and creating a 
new network).

6. Move the cursor over the taskbar icon  to see the connection status (see below).

Figure 7 - 6
Connecting

Figure 7 - 7
Connection Status
7 - 10 Wireless LAN Module
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7. To disconnect from the wireless network you can click the taskbar wireless icon , 
and then select Connect or disconnect to access the network menu, and click 
Disconnect (or right-click the icon , and then click Disconnect from).

Security Enabled 
Networks

You should try to make
sure that any network
you are connecting to is
a secure network.

Connecting to unsecure
networks may allow un-
authorized access to
your computer, docu-
ments, websites and
files etc.

Figure 7 - 8
Disconnecting

Click icon

Right-click icon
Wireless LAN Module 7 - 11
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Bluetooth Module
The optional Bluetooth module allows you to connect your computer to Bluetooth
enabled devices such as other computers, desktop computers, mobile phones, print-
ers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.

Make sure that the Bluetooth module is on. Use the Fn + F12 key combination (see
Table 1 - 5, on page 1 - 9) to toggle power to the Bluetooth module (when the
Bluetooth module is on, the  LED will be orange). 

Bluetooth Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Optional, and then click 3.Install BlueTooth driver > Yes.
3. Choose the language you prefer, and click OK > Next.
4. Click the button to accept the license agreement, and then click Next.
5. Click Next > Install.
6. Click Finish, and the BlueSoleil icon  will appear on the desktop.
7. You can configure the settings at any time by going to the IVT Corpora-

tion BlueSoleil - Main Window (Start > Programs/All Programs > IVT 
BlueSoleil > BlueSoleil), or by clicking the desktop icon .

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Use the Fn + F12 key
combination to toggle
power to the Bluetooth
module, and check the
indicator to see if the
module is powered on or
not (see Table 1 - 5, on
page 1 - 9).
7 - 12 Bluetooth Module
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User Guides & Help

View the BlueSoleil
User Guides from the
Help Menu (or press the
F1 key) in the IVT Cor-
poration BlueSoleil -
Main Window control
panel. 

Click the Help menu
and select Contents
and Index. 

Look through  Getting
Started or select the ap-
propriate User Guide
from the Contents
menu.

Figure 7 - 9
BlueSoleil Main 
Window & Help
Bluetooth Module 7 - 13
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Bluetooth Local Area Connection
You can check the Bluetooth connection status from the Network and Sharing
Center:

1. Use the Fn + F12 key combination to turn on the Bluetooth module.
2. Run the IVT Corporation BlueSoleil program from the desktop icon or Start menu.
3. Click Start, and click Control Panel (or point to Settings and click Control Panel).
4. Double-click Network and Sharing Center (Network and Internet).
5. Click Manage network connections.
6. The Bluetooth connection status will then be displayed in the control panel.

7. To disconnect click File from the IVT Corporation BlueSoleil - Main Window,
and select Exit (the Local Area Connection will then display “Network cable
unplugged”).

Disconnecting

In order to have the Local
Area Connection icon dis-
play the correct connection
status, you will need to exit
the IVT Corporation Blue-
Soleil - Main Window by
clicking the File menu and
selecting Exit (see over).

After exiting the program
you can then use the Fn +
F12 key combination to
turn off the Bluetooth mod-
ule.

If you use the close button,
or turn off the Bluetooth
module (by using the Fn +
F12) the icon will not dis-
play the correct status 

Figure 7 - 10
Local Area 
Connection
7 - 14 Bluetooth Module
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8. Do not use the close  button or Fn + F12 key combination before clicking File >
Exit or the correct status will not be displayed.

9. You can then use the Fn + F12 key combination to turn off the Bluetooth module
(check the LED icon for the Bluetooth module power status).

Figure 7 - 11
Bluetooth 

Disconnected
Bluetooth Module 7 - 15
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PC Camera Module
If you have included the PC Camera module in your purchase option, you will have
the appropriate application provided on the Device Drivers & Utilities + User’s
Manual disc. There are 1.3M or 2.0M pixel camera options available for this com-
puter, depending on your purchase configuration. The BisonCap or Video View ap-
plications (one will be available depending on your camera module) can be used to
capture video files.

Make sure the PC Camera is on. Use the Fn + F10 key combination (see Table 1 -
5, on page 1 - 9) to toggle power to the PC Camera module.
7 - 16 PC Camera Module
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PC Camera Driver Application
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual disc into the CD/DVD drive. 
2. Click Optional, and then click 4.PC Camera, Web cam > Yes.

For the BisonCap Application:
3. Choose the language you prefer and click Next > Next.
4. Click Finish to restart the computer.
5. Run the BisonCap application program from the BisonCam shortcut on the 

desktop, or from the BisonCam item in the Start > Programs/All Pro-
grams menu (if the hardware is turned off use the Fn + F10 key combina-
tion to turn it on again).

For the Video View Application:
1. Click Install.
2. Click to select Yes or No in answer to the power system question.
3. Click Finish > Finish to restart the computer.
4. Run the Video View application program from the Video View shortcut on 

the desktop, or from the USB2.0 PC Camera item in the Start > Pro-
grams/All Programs menu (if the hardware is turned off use the Fn + F10 
key combination to turn it on again).
PC Camera Module 7 - 17
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the BisonCap/Video View application program from the Start > Programs/

All Programs > BisonCam/USB2.0 PC Camera menu.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).

PC Camera & TV 
Tuner

If you have the optional
TV Tuner included in
your purchase, make
sure you select which
device to use with the
BisonCap/Video View
program. Go to the De-
vices menu and select
the Bison Cam, NB Pro/
USB2.0 2M WebCam.
7 - 18 PC Camera Module
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Figure 7 - 12
Audio Setup for PC 

Camera
Right-click
PC Camera Module 7 - 19
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BisonCap
BisonCap is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.

1. Run the BisonCap program from the Start > Programs/All Programs > Bison-
Cam menu (it is recommended that you set the capture file before the capture 
process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 18) and select Start Capture.

3. On the first run of the program (if you have not set the captured file) you will be 
asked to choose a file name and size (see the sidebar - Pre-Allocating File 
Space) for the captured file. Click Start Capture again.

4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video 

As..., choose a file name and location, and then click Open (you can view the file 
using the Windows Media Player).

Set Capture File
In the BisonCap program you will only be asked to set the capture file name on the
first run of the program. When you run the program the next time the file will auto-
matically be overwritten with the newly captured file. To avoid overwriting files you
can go to the Set Capture File.. option in the File menu, and set the file name and
location before capture. Set the name and location then click Open (you can choose
Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate
the file size for the cap-
ture file in the BisonCap
program. You can
choose to ignore this by
clicking Cancel.

Pre-allocating space on
the hard disk can im-
prove the capture quali-
ty (particularly of large
capture files), by reduc-
ing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.
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Eliminating Screen Flicker (BisonCap)
If you find that the video screen in the BisonCap program is flickering, you can try
to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 13
Video Capture Filter
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Video View
Video View is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.

1. Run the Video View program from the Start > Programs/All Programs > USB2.0 
PC Camera menu (it is recommended that you set the capture file before the 
capture process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 18) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the 
video, and press Esc to stop the capture.

Set Capture File
Prior to capturing video files you may Set Capture File... To avoid overwriting files
you can go to the Set Capture File.. option in the File menu, and set the file name
and location before capture. Set the name and location then click Open (you can
choose Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate the
file size for the capture file
in the Video View pro-
gram.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.
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Eliminating Screen Flicker (Video View)
If you find that the video screen in the Video View program is flickering, you can
try to adjust the setting in the Video Capture Filter options.

1. Run the Video View program.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Flickering Reduction in Image (tab).

Figure 7 - 14
Video Capture Filter
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Zoom (Video View)
If you have enabled digital zoom when installing the Video View camera driver you
may use the Options > Setting menu to zoom the camera in and out.

1. Run the Video View program.
2. Go to Options and scroll down to select Setting.
3. Use the slider to adjust the zoom level, and click OK to save the setting.

Still Image Capture (Video View)
You can capture still images by using the Snapshot command from the Capture
menu.

1. Run the Video View program.
2. Go to Capture and select Snapshot.
3. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Figure 7 - 15
Setting

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

Figure 7 - 16
Snapshot Folder
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Mini-PCI TV Tuner Module
A CD containing drivers, software and a user guide will be supplied if your purchase
configuration includes the optional Mini-PCI TV Tuner module. The MPC788
module features both Analog and Hybrid (Analog & Digital) options; the MPC718
is a Hybrid module. You will also be supplied with a remote control unit and appro-
priate antenna and fittings for the Mini-PCI TV Tuner module.

The optional TV Tuner allows you to watch TV, play music CDs, video conference
and capture still images and video on your PC.

The Cable (CATV) antenna jack and S-Video-In jack will only be enabled
when the TV Tuner module is installed. Make sure you install the driver before
connecting the TV antenna.

TV Antenna

The TV antenna supplied
with any TV Tuner module
is intended for indoor use
only. Please do not use
your TV Tuner module out-
doors.

TV Tuner Remote

Point the remote at the con-
sumer IR transceiver to
change channels etc.

Figure 7 - 17
TV Tuner 

Ports/Jacks
1. S-Video-In Jack 

(not supported by 
AverMedia TV 
Tuner module)

2. CATV Antenna 
Jack

2

1
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MPC788/MPC718 Driver & Software
1. Insert the MPC788 or MPC718 driver disc into the CD/DVD drive.
2. Click Vista Driver Setup.
3. Click Install > OK.

MPC788 Module
1. This TV Tuner module requires the installation of the software encoder sup-

plied before running Windows Media Center.
2. Insert the Cyberlink Software Encoder disc into the CD/DVD drive.
3. Click Next > Yes > Next.
4. Click Finish.
5. The multimedia functions are supported by Windows Media Center in Win-

dows Vista (Home Premium Edition & Ultimate Edition).
6. Run Windows Media Center directly from the Start menu (Start > Pro-

grams > Windows Media Center).
7. Windows Help and Support provides information on the Windows Media 

Center functions. Click Start  and select Help and Support, and then 
type “Media Center” in the Search Help box and click the magnifying 
glass icon  to bring up the results.

TV Tuner Module 
Support

Note that the TV Tuner
module options in Win-
dows Vista are support-
ed by the Windows
Media Center software
which comes built-in to
the Windows Vista
Home Premium and Ul-
timate Editions only. 

If your purchase in-
cludes a TV Tuner op-
tion, and you are re-
configuring your system
for a different system,
you should install either
Windows Home Premi-
um or Ultimate Edi-
tions only.
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MPC718 Module
1. This TV Tuner module is fully supported by Windows Media Center in 

Windows Vista (Home Premium Edition & Ultimate Edition).
2. Run Windows Media Center directly from the Start menu (Start > Pro-

grams > Windows Media Center).
3. Windows Help and Support provides information on the Windows Media 

Center functions. Click Start  and select Help and Support, and then 
type “Media Center” in the Search Help box and click the magnifying 
glass icon  to bring up the results.

TV Tuner Module Support

Note that the TV Tuner module (factory) options in Windows Vista are supported by the
Windows Media Center software which comes built-in to the Windows Vista Home Pre-
mium and Ultimate Editions only. 

If your purchase includes a TV Tuner option, and you are re-configuring your system for a
different system, you should install either Windows Home Premium or Ultimate Edi-
tions only.
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Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear digital terrestrial TV
broadcast signal. The passive antenna provided should provide a clear signal when
placed beside a window. If the signal is not clear then you can purchase an active
antenna (it should also be placed beside a window) to improve the signal. You
should also check with any related government website which provides information
on digital terrestrial TV coverage for your area. Note that (unlike standard analog
TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans
If you intend to use the optional TV Tuner to record live TV, then go to the Power
Options control panel and create a power plan (see “Power Plans” on page 3 - 4)
to prevent the power saving options from adjusting the computer’s performance lev-
el.

Remote Control Unit
The remote control unit allows you to remotely start and send the system into a pow-
er saving state, to run Windows Media Center and to navigate the Media Center
menus etc. The remote control unit also gives full control over all TV and video
functions.

CATV Cable Safety

Make sure that your
CATV system installer
has connected the Co-
axial cable shield to the
grounding system of the
building, as close to the
point of cable entry as
practical.

This reminder is provid-
ed to call the CATV sys-
tem installer’s attention
to Article 820-93 of the
NEC (Section 54, Part I
of the Canadian Electri-
cal Code).
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1. Mute
2. Teletext
3. Home
4. Power Button
5. DVD/VCD
6. Music
7. Pictures
8. Videos
9. Back
10. Radio
11. Information
12. Cursor Buttons & OK
13. SAP (Secondary Audio Programming)
14. Live TV
15. DVD Menu
16. Last Channel
17. A/V Navigational Buttons
18. Channel Change
19. Volume
20. Number Pad
21. Clear
22. Enter

1 2 3 4

5 6 7 8

9 10 11

12 13

14 15 16

17

18

19

20

21 22

Figure 7 - 18
Remote Control Unit
(For MPC Modules)
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 7) 
to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Configuring the Power Buttons” on page 3 - 8/“Configuring the Power 
Button” on page D - 20), the Fn + F4 key combination, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 5, on page 1 - 9).

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the 
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Boot password for the SCU (see “Security Menu” on page 5 - 10).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief 
notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).

• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.
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• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
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Problems & Possible Solutions

Problem Possible Cause - Solution

You turned the power on
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present and
seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The Battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the AC power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Plans” on page 3 - 4/“Power Schemes” on page D - 17) check its settings. You may also be
using an ExpressCard/USB device/external device that is drawing a lot of power.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
10/“Battery Information” on page D - 21).

Check the settings of any active power plan (see “Power Plans” on page 3 - 4/“Power
Schemes” on page D - 17).

A peripheral device/USB device/ExpressCard is consuming a lot of power. Turn off/remove the
unused device to save power.
Problems & Possible Solutions 8 - 7
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The computer feels too
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 13). Make sure
you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan
intakes to be blocked.

Nothing appears on
screen.

The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power
Buttons” on page 3 - 8/“Configuring the Power Button” on page D - 20).
\

The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key combinations.
If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should
also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on
the external monitor I
have plugged in and
powered on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
“NVIDIA Video Driver Controls” on page B - 1/“Video Features” on page D - 7 for
instructions on installing and configuring the video driver.

You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

Problem Possible Cause - Solution
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The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, or use the key combination Fn + F5 and F6 (see “Audio Features” on page 2
- 11/“Audio Features” on page D - 4) to adjust.

The compact disc
cannot be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
hole (see “Loading Discs” on page 2 - 3).

The DVD regional
codes can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5/
“DVD Regional Codes” on page D - 2.

The TouchPad doesn’t
work.

The Touchpad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make
sure you have installed the Touchpad driver.

Problem Possible Cause - Solution

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
Problems & Possible Solutions 8 - 9
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The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press a key on the
keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are
lit.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to the Windows Power Options menu and enable
the features you prefer (see “Power-Saving States” on page 3 - 6/“System Power Options”
on page D - 18). Make sure you have enabled Hibernate mode from the control panel.

The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
detected.

The modules are off. Check the appropriate LED indicator  for the WLAN or Bluetooth
module to see if the modules are on or off (see “LED Indicators” on page 1 - 7). If the LED
indicator is off, then press the appropriate function key combination in order to enable the
modules (see Table 1 - 5, on page 1 - 9). 

The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module (see the instructions in Chapter 7 “Modules”/“Module Drivers” on
page D - 29 for the appropriate module).

The PC Camera
software displays a
black screen when the
BisonCap software is
run.

The software is using the incorrect device. If you have both an optional PC Camera and an optional
TV Tuner module present, you will need to select which device to use with the BisonCap program.
Go to the Devices menu in the BisonCap program and select the USB Video Device device.

Problem Possible Cause - Solution
8 - 10 Problems & Possible Solutions
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Ports and Jacks

Item Description

Card Reader The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) RS MMC (requires PC adapter)
SD (Secure Digital) Mini SD (requires PC adapter)
MS (Memory Stick) MS Duo (requires PC adapter)
MS (Memory Stick Pro)

Cable (CATV) 
Antenna Jack

Use this jack to connect a CATV cable if you have included the optional Mini-PCI TV Tuner in
your purchase.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

DVI-Out Port The DVI-Out (Digital Visual Interface) Port (at the rear of the computer) allows you to connect an
external monitor, or Flat Panel Display, to allow dual video or simultaneous display on the LCD
and external monitor/FPD (see “- Display Modes Available” on page 1 - 16). If you are using
an older type of monitor you will need to use a converter to convert the signal from DVI to VGA.

External Monitor Port The External Monitor Port (on the left of the computer) allows you to connect an external monitor,
or Flat Panel Display, to allow dual video or simultaneous display on the LCD and external
monitor/FPD (see “- Display Modes Available” on page 1 - 16). 
A - 2 Interface (Ports & Jacks)
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Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers. Note that
audio input through Line-in will default to the mute setting. To set up your audio sources to play
through the Line-in jack go to the Sound control panel  and make sure the Mute box is not
ticked.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Mini-IEEE 1394 Port This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).

RJ-11 Phone Jack This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11
telephone connection. 

Item Description

IEEE 1394
The Mini-IEEE 1394 ports only support SELF POWERED IEEE 1394 devices.
Interface (Ports & Jacks) A - 3
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RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

S-Video-In Jack The S-Video-In jack allows video input to the computer if you have included the optional Mini-
PCI TV Tuner in your purchase.

S-Video-Out Jack Connect your television to your computer and view DVDs, VCDs or anything else your computer
can display. (Note that NVIDIA Quadro FX 3700M, GeForce 9800M GT, GTX & GTS video cards
are supported in Windows Vista only, and DO NOT support the S-Video-Out Jack.)

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

Item Description
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Appendix B: NVIDIA Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 15.

NVIDIA Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

2. Click 1.Install Video Driver > Yes.
3. Click Next.
4. Click Finish to restart the computer.

Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your service center for
the latest details on vid-
eo cards supported.

Note that NVIDIA
Quadro FX 3700M,
GeForce 9800M GT,
GTX & GTS video cards
are supported in Win-
dows Vista only, and
DO NOT support the S-
Video-Out Jack.

Screen Flickering

Note that the display may briefly flicker during display device detection (switching dis-
plays etc.), or if changes in resolution or mode settings are taking place (this includes
resuming from power saving modes, opening and closing the lid and logging on to Win-
dows etc.). 
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NVIDIA Control Panel
More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Open the Display Settings (see page 1 - 16) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).

NVIDIA Control 
Panel 

To access the Ge-
Force..... control pan-
el from the desktop;
right-click the desk-
top, then click NVIDIA
Control Panel.

Figure B - 1
NVIDIA GeForce..... 

Control Panel
B - 2 NVIDIA Control Panel
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The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as display configuration, 3D Settings
and Help menus etc. Navigating the 

Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Figure B - 2
NVIDIA Control 

Panels
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The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

Figure B - 3
Help Menus
B - 4 NVIDIA Control Panel
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SLI Multi GPU Configuration
This computer features an NVIDIA Scalable Link Interface (SLI) that improves
graphic quality and performance by combining dual NVIDIA GPUs in a single sys-
tem. To enable/disable SLI Configuration:
3. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page  B - 2).
4. Double-click 3D Settings, and then click Set SLI Configuration.

5. Click to “Select the SLI configuration for your system.”.
6. Click to “Select the display to view the SLI rendered content on.” (only a single

display may be used).
7. Click Apply > Yes (you will need to close any open applications), and Yes to restart

the computer (see over).

SLI Configuration & 
Multiple Displays

Note that if SLI configu-
ration is enabled only a
Single display may be
used as the display de-
vice.

Figure B - 4
Set SLI 

Configuration
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SLI Multi GPU Configuration & Battery Power
Note that due to the high power and system demands created by enabling SLI Con-
figuration, you should not enable SLI configuration if your computer is powered
by battery only. If you attempt to run an SLI configuration when the computer is
powered by the battery only, then system problems may occur.

• If the computer is currently powered by battery only do not enable SLI config-
uration. 

• If you have currently enabled SLI configuration, and the computer is powered 
by the AC/DC adapter, do not switch to battery power only (or go to the 
NVIDIA Control Panel and disable SLI configuration before switching to bat-
tery power only).
B - 6 SLI Multi GPU Configuration & Battery Power
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Display Devices
Besides the built-in LCD, you can also use an external monitor/flat panel display or
TV (if supported) as your display device. The following are the display options:

1. The built-in LCD.
2. An external monitor connected to the DVI-Out Port or external monitor port.
3. A flat panel display connected to the DVI-Out Port (or external monitor port for

older models).
4. A TV connected to the S-Video-Out jack (see “S-Video-Out Jack” below).

Function Key 
Combination

You can use the Fn + F7
key combination to tog-
gle through some dis-
play options:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aeri-
al to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tun-
er first, then the monitor.

SLI Configuration & Multiple Displays

Note that if SLI configuration is enabled only a Single display may be used as the display
device.

S-Video-Out Jack

Note that NVIDIA Quadro FX 3700M, GeForce 9800M GT, GTX & GTS video cards DO
NOT support the S-Video-Out Jack.
Display Devices B - 7



NVIDIA Video Driver Controls

B

Attaching Other Displays
Configuring an External Display in Windows Vista
1. Attach your external display to the external monitor port/DVI-Out Port and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preferences, or click
Display Settings (in the New Display Detected window) to access the control
panel.

Figure B - 5
New Display 

Detected
B - 8 Attaching Other Displays
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Configuring an External Display using the NVIDIA Control Panel
Alternatively you can use the NVIDIA control panel to configure any attached dis-
plays.
1. Attach your external display to the external monitor port/DVI-Out Port (or TV to the 

S-Video-Out jack if supported by your video card), and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page  B - 2).
3. Double-click Display, and then click Set up multiple displays.

4. Click to select the nView display mode you wish to use (see page B - 10).
5. Select the display(s) you want to use (if your display is not shown click “My Display

is not shown in the list...”), and choose which display is to be the primary display.
6. Click Apply > Yes to save the changes.

SLI Configuration & 
Multiple Displays

Note that if SLI configu-
ration is enabled only a
Single display may be
used as the display de-
vice.

Figure B - 6
Set Up Multiple 

Displays
Attaching Other Displays B - 9
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Display Modes
Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other
display(s). This mode will drive multiple displays with the same content.

Dualview Mode
Dualview Mode (or Extended Mode in Windows Vista - see overleaf) treats both
connected displays as separate devices, and they act as a virtual desktop resulting in
a large workspace. When Dualview is enabled, you can drag any icons or windows
across to the other display desktop. It is therefore possible to have one program vis-
ible in one of the displays, and a different program visible in the other display.

Blu-ray/HD-DVD 
Support

If your optical device drive
option includes a Blu-ray/
HD-DVD device, please
note the following:

The GeForce Go 7950
GTX video card DOES
NOT support HDCP (high-
bandwidth digital-content
protection), and therefore
will not play content
through the DVI-Out port
or S-Video Out Jack on
the computer.

If you wish to display con-
tent from the Blu-ray/HD-
DVD device on an external
display, then use External
Monitor Port to connect
the computer to the exter-
nal display using Single or
Dualview display modes
(do not use Clone mode).
B - 10 Display Modes
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Using New Display Detected to Enable Extended Mode
1. Attach your external display to the external monitor port/DVI-Out Port (or TV to the 

S-Video-Out jack if supported by your video card), and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

Figure B - 7
New Display 

Detected 
(Extended)
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Using Display Settings to Enable Extended Mode
1. Attach your external display to the external monitor port/DVI-Out Port (or TV to the 

S-Video-Out jack if supported by your video card), and turn it on.
2. Click Start, and click Control Panel (or point to Settings and click Control

Panel).
3. Click Adjust screen resolution under the Appearance and Personalization

menu (or double-click Personalization > Display Settings).
4. Click the monitor icon (e.g. ), and make sure you have checked “Extend the

desktop onto this monitor.” and click Apply.

 Display Settings 
Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 8
Display Settings 

(Extend the 
Desktop)

2

Click the appropriate monitor
icon (e.g. ) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor  is on the left, the secondary
display  is on the right.

2

1
2
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Enabling TV Display
To display desktop images on a TV, connect the TV to your computer by using an
S-Video cable from the TV to the S-Video-Out jack (see sidebar for support infor-
mation for your video card) on the left of the computer.

You will need to enable the TV display from the NVIDIA Control Panel as per the
instructions on B - 9. The TV will appear as a display option (2. Select the displays
you would like to use.) when attached to the S-Video-Out jack. Apply the settings,
and then click Yes to save the changes.

Detect Displays

To get a full range of dis-
play options click  “My
display is not shown in
the list...”.

S-Video-Out Jack

Note that NVIDIA
Quadro FX 3700M, Ge-
Force 9800M GT, GTX
& GTS video cards DO
NOT support the S-Vid-
eo-Out Jack.

Figure B - 9
Set Up Multiple 

Displays 
(with TV connected) 
Enabling TV Display B - 13
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Changing the TV Signal Format
1. When the TV is enabled as a display device, click the sub-menus under Video & 

Television.
2. Click “Change the signal or HD format”
3. Select the TV signal format (the menu allows you to select TV format by country if

you are unsure of your TV format).
4. Apply the settings, and then click Yes to save the changes.

Figure B - 10
Change the Signal or 

HD Format
B - 14 Enabling TV Display
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Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.
Specifications C - 1
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Feature Specification

Processor Types Intel® Core™ 2 Duo Processor
LGA775 Package (775-pin)
E6300/ E6400

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 1066MHz FSB
1.86/ 2.13 GHz

Intel® Core™ 2 Duo Processor
LGA775 Package (775-pin)
E6600/ E6700

65nm (65 Nanometer) Process Technology
4MB On-die L2 Cache & 1066MHz FSB
2.40/ 2.67 GHz

Intel® Core™ 2 Duo Processor
LGA775 Package (775-pin)
E6550/ E6850

65nm (65 Nanometer) Process Technology
4MB On-die L2 Cache & 1333MHz FSB
2.33/ 3.0 GHz

Intel® Core™ 2 Quad Processor
LGA775 Package (775-pin)
Q6600/ Q6700

65nm (65 Nanometer) Process Technology
G0 Stepping
8MB On-die L2 Cache & 1066MHz FSB
2.4/ 2.66 GHz

Intel® Core™ 2 Extreme Processor
LGA775 Package (775-pin)
X6800

65nm (65 Nanometer) Process Technology
4MB On-die L2 Cache & 1066MHz FSB
2.93 GHz

Core Logic Intel P965 + ICH8-R
C - 2 Specifications
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LCD 17.1" Glare Type Flat Panel TFT (For One of the Following Options)

WXGA (1440 * 900) 
OR
WSXGA+ (1680 * 1050)
OR
WUXGA (1920 * 1200)

Security Security (Kensington® Type) Lock Slot BIOS Password

Memory Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 533/667/800 MHz
64-bit Wide DDRII (DDR2) Data Channels
Memory Expandable up to 4GB (512/ 1024/ 2048 MB DDRII Modules Supporting HDCP) 
(Note: Do Not Use Other Module Types)

BIOS One 16Mbit Flash ROM Phoenix BIOS

Feature Specification
Specifications C - 3
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Video Card 
Options

For Windows VISTA ONLY:
NVIDIA Quadro FX 3700M PCI-E Video Card
1GB GDDR3 Video RAM On Board
MS DirectX® 10 Compatible, HDCP Supported
(Note: This Video Card DOES NOT Support the 
S-Video-Out Jack for TV & HDTV Output)

For Windows VISTA ONLY:
NVIDIA GeForce 9800M GTS PCI-E Video 
Card - SLI Compatible (NVIDIA Scalable Link 
Interface supported)
1GB GDDR3 Video RAM On Board
MS DirectX® 10 Compatible, HDCP Supported
(Note: This Video Card DOES NOT Support the 
S-Video-Out Jack for TV & HDTV Output)

For Windows VISTA & WinXP:
NVIDIA GeForce 8800M GTX PCI-E Video 
Card - SLI Compatible (NVIDIA Scalable Link 
Interface supported)
512MB GDDR3 Video RAM on Board
MS DirectX® 10 Compatible, HDCP Supported

For Windows VISTA ONLY:
NVIDIA GeForce 9800M GT PCI-E Video Card 
- SLI Compatible (NVIDIA Scalable Link 
Interface supported)
512MB GDDR3 Video RAM On Board
MS DirectX® 10 Compatible, HDCP Supported
(Note: This Video Card DOES NOT Support the 
S-Video-Out Jack for TV & HDTV Output)

For Windows VISTA ONLY:
NVIDIA GeForce 9800M GTX PCI-E Video 
Card - SLI Compatible (NVIDIA Scalable Link 
Interface supported)
1GB GDDR3 Video RAM On Board
MS DirectX® 10 Compatible, HDCP Supported
(Note: This Video Card DOES NOT Support the 
S-Video-Out Jack for TV & HDTV Output)

Feature Specification

Video Card 
Options

Note that card
types, specifica-
tions and drivers
are subject to
continual up-
dates and
changes. Check
with your service
center for the lat-
est details on
video cards sup-
ported.
C - 4 Specifications
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Storage Options One Changeable 12.7 mm (h) Optical Device Drive Bay (see“Optional” on page C - 8)

Up to Three Changeable 9.5 mm (h) SATA II Hard Disk Drives
Supports 5400RPM/ 7200RPM RAID 0, RAID 1, RAID 5 HDD Fault Tolerance System

(Optional) External USB 1.44MB Floppy Disk Drive 

Card Reader Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Note: MS Duo/ Mini SD/ RS MMC Cards Require a PC Adapter

Audio UAA (Universal Audio Architecture)
Integrated Azalia Compliant Interface

S/PDIF Digital Output 
Built-In Microphone
4 * Built-In Speakers

Keyboard & 
Pointing Device

Full Size Winkey Keyboard with Numeric Keypad
Two Game Hot Keys

Built-In TouchPad (Scroll Functionality Included)

ExpressCard Slot ExpressCard/34/54 Slot

Feature Specification
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I/O Ports Four USB 2.0 Ports
One Mini-IEEE1394a Port

One S-Video-Out Jack for TV & HDTV Output 
(Not supported by NVIDIA GeForce 9800M GT 
or NVIDIA GeForce 9800M GTX)

One DVI-Out Port
One External Monitor Port
One Headphone/Speaker-Out Jack
One Microphone-In Jack
One S/PDIF Out Jack
One Line-In Jack for Audio Input

One RJ-11 Modem Jack
One RJ-45 Gigabit LAN Jack
One DC-In Jack

One CATV Antenna (Analog/Digital) Jack 
(Functions with Optional TV Tuner Module)
One S-Video-In Jack
(Functions with Optional TV Tuner Module)
One Consumer Infrared Transceiver 
(Functions with Optional TV Tuner Module)

Communication AZALIA MDC 56K Modem (V.90 & V.92 Compliant)

1GB Gigabit LAN On Board

Intel PRO/Wireless 3945ABG PCIe Wireless LAN 
Module (Option)
Intel PRO/Wireless 4965AGN PCIe Wireless LAN 
Module (Option)

USB 2.0 Bluetooth Class II Module (Option)

1.3M/2.0M Pixel USB 2.0 PC Camera Module 
(Factory Option)

Operating 
Systems 
Supported

Windows XP SP2 Windows Vista 64bit 
Home Premium/ Business/ Enterprise/ Ultimate

Feature Specification
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Power 
Management

Supports ACPI 2.0
Battery Low Suspend
Supports Resume from Modem Ring

Supports Suspend to RAM (S3)
Supports Suspend to Disk (S4)

Power Full Range 220W AC/DC Adapter – AC Input 100 - 240V, 50 - 60Hz, DC Output 20V, 11A

Easy Changeable 12-Cell Smart Lithium-Ion 6600mAH

Environmental 
Spec

Temperature
Operating: 5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%

Physical 
Dimensions & 
Weight

397mm (w) * 298mm (d) * 51 ~ 60mm (h) 5.4kg

Feature Specification
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Optional Optical Drive Module Options:
Combo Drive Module
DVD-DUAL Module
DVD-Super Multi Drive Module
Blu-ray Drive Module
HD-DVD Drive Module

External USB 1.44MB Floppy Disk Drive

Analog TV Tuner Module with Mini-PCI Interface
OR
Hybrid TV Tuner Module with Mini-PCI Interface

Intel PRO/Wireless 3945ABG PCIe Wireless LAN 
Module
Intel PRO/Wireless 4965AGN PCIe Wireless LAN 
Module

USB 2.0 Bluetooth Class II Module

1.3M/2.0 Pixel USB 2.0 PC Camera Module 
(Factory Option)

DVD Player Software

Feature Specification
C - 8 Specifications



Windows XP Information

D

Appendix D: Windows XP Information
This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows XP OS.
D - 1



Windows XP Information

D

DVD Regional Codes

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong

4 South & Central America, Mexico, Australia, 
New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

Table D - 1 - DVD Region Codes Figure D - 1 - DVD Regions

Changing DVD Regional Codes

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives.
Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control
panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
D - 2 DVD Regional Codes
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Windows XP Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see
all controls it may be necessary to toggle off Category View.

Figure D - 2 - Start Menu & Control Panel

Click here to toggle Category View
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Audio Features
You can configure the audio options on your computer from the Sounds and Audio
Devices  Windows control panel. For advanced options double-click the Realtek
HD Audio Manager  icon in the taskbar (or click the control panel) to bring up
the Realtek Audio Configuration menus. The volume may also be adjusted by means
of the Fn + F5/F6 key combination.

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows (and the volume
control function keys on
the computer). Click the
Volume icon on the
taskbar to check the set-
ting.

 Figure D - 3
Realtek Audio 
Configuration 

Menus
D - 4 Audio Features
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Application Hot Key
The hot key buttons give instant access to the default Internet browser and e-mail
program, and to a user-defined application, with one quick button press. To configure
a program to open when the application hot key  is pressed (Windows Media
Player is the default program), follow the instructions below (make sure you install
the Ap-Key Utility driver - see “TouchPad” on page D - 29).

1. Right click the Hot Key driver icon  in the taskbar.
2. Select Setup from the menu, scroll to Application 1 and press Enter.

3. An Open dialog box will appear on the screen.

4. Browse to the directory where the desired application.exe (see the sidebar) program 
exists.

5. Double-Click on the program file or choose Open.

Application.exe

You will need to locate the
actual application exe-
cutable (.exe) file, not
just the shortcut. To find
the application right-click
its shortcut on the desk-
top and click Properties.
Click the shortcut (tab)
and see where the exe-
cutable file is located by
clicking the Find Target
(button).

Figure D - 4
Hot Key 

Configuration
Application Hot Key D - 5
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Game Keys
The two game hot keys on the left of the computer allow macros to be configured for
common keystrokes used in applications (the keys can assigned macros for any pro-
gram, not only games). To configure the keys follow the instructions below.

1. Run the Game Key Configuration program from the desktop icon  (or from C:\Win-
dows\CleGameKey\GmKeyCfgUtl.exe).

2. Double-click the button  for the appropriate key (it will turn red ).
3. When the button is red  you may then record the keystrokes to be assigned to the 

Game Key.

4. Click OK.
5. Repeat the procedure for the other Game Key if required.
6. Close the Game Key Configuration window.
7. The keystroke order will be repeated with the appropriate button press in any application 

program.

Figure D - 5
Game Key 

Configuration
D - 6 Game Keys
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Video Features
You can switch display devices, and configure display options, from the Display
Properties control panel in Windows as long as the appropriate video driver is in-
stalled. 

To access Display Properties in Windows:
1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution  (Figure D - 6 on page 

D - 8).
5. Click the arrow, and scroll to the preferred setting in Color quality (Figure D - 6 on 

page D - 8).
6. You can also access Display Properties by right-clicking the desktop and scrolling 

down and clicking Properties. Click Settings (tab) and adjust as above.
7. Open the Display Properties control panel, and click Advanced (button)  (Figure D 

- 6 on page D - 8) to bring up the Advanced properties tabs.
8. Click Start the NVIDIA Control Panel (click to select Standard or Advanced 

options and click OK)
9. Click on any of the menu items on the left to display the appropriate control panel.

GeForce Control 
Panel

To access the Ge-
Force..... control panel
from the desktop:

Right-click the desktop,
then point to or click
NVIDIA Control Panel.

Video Card Options

Note that NVIDIA
Quadro FX 3700M,
GeForce 9800M GT,
GTX & GTS video cards
are supported in Win-
dows Vista only, and
DO NOT support the S-
Video-Out Jack.

1

2

3
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Display Properties

Figure D - 6 - Display Properties & NVIDIA Control Panel

1 2

3

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. This computer features an NVIDIA Scalable Link
Interface (SLI) that improves graphic quality and performance by combining dual NVIDIA GPUs in a single system for some of the video card op-
tions. SLI Configuration needs to be enabled from the NVIDIA Control Panel; see “SLI Multi GPU Configuration” on page D - 10.
Check with your service center for the latest details on video cards supported (see “Video Card Options” on page C - 4 for details). SLI Con-
figuration should not be enabled under battery power (see page B - 6).
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Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or
TV as your display device. A VGA monitor/Flat Panel Display connects to the DVI-Out port or external monitor
port; a TV to the S-Video-Out jack (if supported by your video card). The following display modes are available.

Table D - 2 - Display Options

Display Mode Description Note

Single Display Mode Only one of your displays is used. Note that SLI config-
uration supports 
only Single display.

Note that NVIDIA 
GeForce 9800M GT 
& GTX video cards 
DO NOT support the 
S-Video-Out Jack.

Clone Mode Clone Mode simply shows an exact copy of the Primary display desktop on the other dis-
play(s). This mode will drive multiple displays with the same content.

Dualview Mode

Dualview Mode treats both connected displays as separate devices, and they act as a vir-
tual desktop resulting in a large workspace. When Dualview is enabled, you can drag any 
icons or windows across to the other display desktop. It is therefore possible to have one 
program visible in one of the displays, and a different program visible in the other display.

Blu-ray/HD-DVD Support

If your optical device drive option includes a Blu-ray/HD-DVD device, please note the following:

The GeForce Go 7950 GTX video card DOES NOT support HDCP (high-bandwidth digital-content protection), and therefore will not
play content through the DVI-Out port or S-Video Out Jack on the computer. If you wish to display content from the Blu-ray/HD-
DVD device on an external display, then use External Monitor Port to connect the computer to the external display using Single or
Dualview display modes (do not use Clone mode).
Video Features D - 9
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SLI Multi GPU Configuration
This computer features an NVIDIA Scalable Link Interface (SLI) that improves
graphic quality and performance by combining dual NVIDIA GPUs in a single sys-
tem. To enable/disable SLI Configuration:
1. Go to NVIDIA Control Panel (see “Video Features” on page  B - 7).
2. Click Set SLI Configuration (3D Settings), and then click “Enable SLI technology”.
3. Click Apply to save the settings.

SLI Configuration & 
Multiple Displays

Note that if SLI configura-
tion is enabled only a Sin-
gle display may be used as
the display device.

SLI Configuration & 
Battery Power

Note that due to the high
power and system de-
mands created by enabling
SLI Configuration, you
should not enable SLI
configuration if your
computer is powered by
battery only (see page B -
6).

Figure D - 7 
Set SLI 

Configuration
D - 10 SLI Multi GPU Configuration
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Control Panels (NVIDIA)
The NVIDIA Control Panel provides additional video configuration controls and
tools which allows quick access to features such as display configuration, appear-
ance, mobile support and Help menus etc.

Navigating the 
Control Panel 

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the headings,
menus and highlighted
links for information.
Use the buttons on the
top left to go back, for-
ward etc.

The Help menus pro-
vide index and search
features, and direct
links to the NVIDIA
website etc.

Figure D - 8
NVIDIA Control 

Panels
SLI Multi GPU Configuration D - 11
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Attaching Other Displays
1. Attach your external display to the external monitor port/DVI-Out Port (or TV to the S-

Video-Out jack if supported by your video card), and turn it on.
2. Go to NVIDIA Control Panel (see “Video Features” on page  B - 7).
3. Click Set up multiple displays (Display).
4. Select the display mode and displays you want to use from the menu.
5. Select the Primary display if you are using Dualview Mode.
6. Click Apply (and Yes to confirm the settings change).

Figure D - 9 - Set Up Multiple Displays

Function Key 
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

• Notebook Only
• External Display 

Only
• Notebook + External 

Display

Make sure you give the
displays enough time
to refresh.

Detect Displays

To get a full range of dis-
play options click “My
display is not shown
in the list...”.

SLI Configuration & 
Multiple Displays

Note that if SLI configu-
ration is enabled only a
Single display may be
used as the display de-
vice.
D - 12 Attaching Other Displays
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7. Click Change Resolution (Display) to adjust the display resolution for any attached displays.
8. Click the display icon and use the sliders to adjust the resolution.
9. Click Apply (and Yes to confirm the settings change).

 
Figure D - 10 - Change Resolution
Attaching Other Displays D - 13



Windows XP Information

D

To Enable Windows Extended Desktop
1. Attach your external monitor to the external monitor port and turn it on.
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View choose 

Appearance and Themes).
3. Double-click Display (icon).
4. Click Settings (tab).
5. Click the monitor icon (e.g. ), and make sure you have checked “Extend my Windows desktop onto this monitor.” 

and click Apply.

Figure D - 11 - Display Properties (Extended Desktop)

2

Click the appropriate moni-
tor icon (e.g. ) to be able to
select the option to extend
the desktop on to it.

In this example the Primary
monitor  is on the left, the
secondary display  is on
the right.

2

1
2

 Display Settings Extended 
Desktop

Use the control panel to drag the moni-
tors to match the physical arrangement
you wish to use. 

You can drag any icons or windows
across to either display desktop, which
makes it possible to have one program
visible in one of the displays, and a dif-
ferent program visible in the other dis-
play.
D - 14 Attaching Other Displays
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Enabling TV Display
To display desktop images on a TV, connect the TV to your computer by using an S-
Video cable from the TV to the S-Video-Out jack (see sidebar for support informa-
tion for your video card) on the left of the computer.

You will need to enable the TV display from the NVIDIA Control Panel as per the
instructions on D - 12. The TV will appear as a display option (2. Select the displays
you would like to use.) when attached to the S-Video-Out jack. Apply the settings,
and then click Yes to save the changes.

Figure D - 12 - Set Up Multiple Displays for TV

Detect Displays

To get a full range of dis-
play options click “My
display is not shown
in the list...”.

S-Video-Out Jack

Note that NVIDIA
Quadro FX 3700M,
GeForce 9800M GT,
GTX & GTS video
cards DO NOT support
the S-Video-Out Jack.
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Changing the TV Signal Format
1. When the TV is enabled as a display device, click the sub-menus under Video & Television.
2. Click “Change the signal or HD format”
3. Select the TV signal format (the menu allows you to select TV format by country if you are unsure of your TV format).
4. Apply the settings, and then click Yes to save the changes.

Figure D - 13 - Change TV Signal Format
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Power Management Features
The Power Options control panel icon in Windows (see page D - 3) allows you to configure power management
features for your computer. You may conserve power through individual components such as the monitor or hard
disk, or you may use either Stand by or Hibernate mode to conserve power throughout the system.

Power Schemes
You can set your computer to conserve power through individual components by means of Power Schemes.
You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the com-
puter's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if
the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set
a specified time for the system to enter Stand by or Hibernate modes.

Figure D - 14 - Power Schemes

Resuming Operation

Press the Sleep/Resume
key combination (Fn + F4),
or power button to resume
from Monitor or Hard Disk
Stand by.
Power Management Features D - 17



Windows XP Information

D

Each Windows Power Scheme will also adjust the processor performance of your machine in order to save pow-
er. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery
power).

Choose the Home/Office Desk scheme for maximum performance when the computer is powered from an AC
power source. Choose the Max Battery scheme (bear in mind that this scheme may slow down the overall per-
formance of the computer in order to save power) for maximum power saving when the computer is battery (DC
power) powered. Windows will use Portable/Laptop as the default scheme.

System Power Options
You can use the system power options to stop the computer’s operation and restart where you left off. This sys-
tem features Stand by and Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking
the option in the Hibernate tab in the Power Options control panel).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to
turn it on. When you come back from hibernation, you can return to where you last left off (what was on your
desktop) without reopening the application(s) and file(s) you last used.

Stand by Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the system on Stand by instead of in hi-
bernation. It takes a longer time to wake up the system from Hibernate mode than from Stand by mode.
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Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full operation. During Stand by
the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained
in memory. When you are not using your computer for a certain length of time, which you specify in the oper-
ating system, it will enter Stand by mode to save power. 

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off.
Although it saves the most power it takes the longest time to return to full operation. You can set your computer
to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hi-
bernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hi-
bernate mode by pressing the power button.

Figure D - 15 - Enable Hibernation

System Resume

The system can resume from Stand by mode by:

• Pressing the power button

• An incoming call received on the modem (if enabled)

• Network card activity (if enabled)
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Configuring the Power Button
The power button may be set to send the computer in to either Stand by or Hibernate mode. In Stand by mode,
the LED  will blink green. In Hibernate the LED will be off (battery) or orange (AC/DC adapter). If you
are in a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED
will remain green.

Figure D - 16 - Power Options (Advanced - Power Buttons)

(Sleep) Button
Power Button Sleep/ResumeLid

Sleep Button

You may also configure
the Sleep/Resume key
combination (Fn + F4).
In Windows this is re-
ferred to as the Sleep
button.
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 24).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and pe-
ripheral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power
Meter from the Power Options control panel), and settings in the OS will help prolong the battery life if con-
figured appropriately.

Figure D - 17 - Power Options (Alarm & Power Meter)

Low Battery Warning

When the battery is critically low, immediately
connect the AC/DC adapter to the computer or
save your work, otherwise, the unsaved data
will be lost when the power is depleted.
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Battery life may be shortened through improper maintenance. To optimize the life and improve its perfor-
mance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason
see “Removing the Battery” on page 6 - 3.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical out-
let. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the
computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 7 for information on the battery charge status, and to “Battery Information” on page D - 21
for more information on how to maintain and properly recharge the battery pack.)

Conserving Battery Power

To conserve battery power:

Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by
the AC/DC adapter.

Close modem or communication applications when they are not being used.

Remove any unused Express Cards from the computer (Express Cards quickly use up battery power even if the system enters sleep mode).

Disconnect any unnecessary external devices.
D - 22 Battery Information



Windows XP Information

D

Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells
emanating from the notebook battery, shut your computer down immediately and contact your service center. If the bat-
tery has been dropped we do not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace
your computer battery every two years.
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by
yourself even when you see a message that indicates the battery is critically low, just let the computer use up all
of the battery power and shut down on its own. Disable the Power Options functions in the Control Panel, es-
pecially any Alarms (unclick the tickboxes - see page D - 21) and Schemes (change all the settings to Never -
see page D - 17). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

Caution

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the
manufacturer’s instructions.
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Driver Installation
The Device Drivers & Utilities + User’s Manual disc contains the drivers and utilities necessary for the proper
operation of the computer. Table D - 3 lists what you need to install, and it is very important that the drivers
are installed in the order indicated.

Table D - 3 - Driver Installation

WinXP SP2 Driver Page # Notes

Chipset D - 28

The Mini-PCI TV Tuner Module driver and Cyberlink PowerCinema appli-
cation are provided on a separate CD-ROM for Windows XP.

Video D - 28

Audio D - 28

Modem D - 28

LAN D - 28

TouchPad D - 29

Card Reader/Express Card D - 29

AP-Key Utility D - 29

RAID Utility D - 32

Wireless LAN Module D - 37

Bluetooth D - 39

PC Camera D - 43

RAID or AHCI Setup

Note that setting up a RAID, or AHCI mode, needs to
be done prior to installing the Windows OS, and there-
fore before installing the other drivers listed here.
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What to Install
This section covers driver and utility installation instruc-
tions for Windows XP Home & Professional. Insert the
Device Drivers & Utilities + User’s Manual disc and
click Install Drivers (button), or click Optional (but-
ton) to access the Optional driver menu.

Figure D - 18 - Drivers Installer Screen 1

1. Check the driver installation order from Table D - 3 
(the drivers must be installed in this order) which is 
the same as that listed in the Drivers Installer menu 
below.

2. Click to select the driver you wish to install, after 
installing each driver it will become greyed out (if you 
need to reinstall any driver, click the Unlock button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following pages.

Figure D - 19 - Drivers Installer Screen 2
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Add/Remove Programs item. If you
see the individual driver listed (if not see below), un-
install it, following the on screen prompts (it may be
necessary to restart the computer). Go to the appropri-
ate section of the manual to complete the update/rein-
stall procedure for the driver in question.

If the driver is not listed in the Add/Remove Pro-
grams item:
1. Click Start (menu), point to Settings and click Control 

Panel (or click Start > Control Panel). 
2. Double-click System (icon); System (icon) is in 

Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the 

driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver 

tab) and follow the on screen prompts.

Windows XP Service Pack 2

Make sure you install Windows XP Service Pack 2 (or a
Windows XP version which includes Service Pack 2) be-
fore installing any drivers. Service Pack 2 includes sup-
port for USB 2.0.

If you have upgraded the system by installing Service
Pack 2 (i.e. your Windows XP version does not include
Service Pack 2) then follow these instructions:

1. Click Start (menu), point to Settings and click Con-
trol Panel (or click Control Panel).

2. Double-click System (icon); System (icon) is in Per-
formance and Maintenance (category).

3. Click the Hardware (tab) > Device Manager (but-
ton). 

4. Click “+” next to Other Devices (if its sub-items are
not shown).

5. Right-click Universal Serial Bus (USB) Controller
and select Uninstall > OK (if you don’t see the item
then there is no need to take any further action).

6. Restart the computer and it will find the USB 2.0 con-
troller.
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Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next (click Continue Anyway if asked if 

you want to continue at any time).
3. Click “Yes, I want to restart my computer 

now” (button).
4. Click Finish to restart the computer.

Audio
1. Click 3. Install Audio Driver > Yes.
2. Click Next (click Cancel if a Found New 

Hardware Wizard appears).
3. Click Finish to restart the computer.

Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.
3. The modem is now ready for configuration.

LAN
1. Click 5.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Modem Country Selection

Be sure to check if the modem country selection is appropri-
ate for you (Control Panel > Phone and Modem Options).
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TouchPad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next > Next > Next.
3. Click Finish to restart your computer.

Card Reader/ExpressCard
1. Click 7.Install CardReader Driver > Yes.
2. Click Next.
3. Click the button to accept the license, and then 

click Next.
4. Click Finish.

Ap-Key Utility
1. Click 8.Install AP-key Utility > Yes.
2. Click Next.
3. The GameKey icon will appear on the desktop 

when the driver is installed.
4. See “Application Hot Key” on page D - 5 and 

“Game Keys” on page D - 6 for configuration 
instructions.

Module Drivers
See the following pages for the driver installation pro-
cedures for any of the optional modules included in
your purchase configuration.
Bluetooth & Wireless LAN Modules

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices
aboard aircraft is usually prohibited. Make sure the module(s)
are OFF if you are using the computer aboard aircraft.

Power Toggle for the Wireless LAN and Bluetooth 
Modules

Enable power to the modules as follows:

Fn + F11 = Wireless LAN Module Power Toggle
Fn + F12 = Bluetooth Module Power Toggle

When the WLAN module is on, the  LED will be green.
When the Bluetooth module is on, the  LED will be or-
ange.
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Setting Up SATA RAID or AHCI Modes
AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows the storage driver to enable
advanced Serial ATA features such as Native Command Queuing (for maximum hard disk efficiency and per-
formance). AHCI mode can be supported by one, two or three hard disks.

RAID
You may use your hard disks (if you have included more than one hard disk in your purchase option) in combi-
nation with Striping (RAID 0), Mirroring (RAID 1) or Parity Across Disks (RAID 5) for either fault tolerance
or performance. To configure your system in Striping (RAID 0) or Mirroring (RAID 1) modes you will require
at least two hard disks; to configure your system in Parity Across Disks (RAID 5) mode you will require three
hard disks installed.

Table D - 4 - RAID Levels

RAID Level Description

RAID 0 Identical drives reading and writing data in parallel to increase performance. RAID 0 implements a striped disk 
array and the data is broken into blocks and each block is written to a separate disk drive.

RAID 1
Identical drives in a mirrored configuration used to protect data. Should a drive that is part of a mirrored array fail, 
the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, 
data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.

RAID 5 Identical drives (at least three drives must be used) in a parity across disks configuration are used to protect data 
and increase performance. A RAID 5 array can withstand a single disk failure without losing access to data.
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What to Prepare for RAID or AHCI Setup
Prepare the following before setting up your serial ATA hard disks in RAID mode (to configure AHCI mode
you do not need to prepare any extra hard disks but will need to install the Intel Matrix driver):

1. An operable computer (to create a SATA RAID/AHCI driver diskette).
2. An external USB floppy disk drive.
3. A prepared formatted blank 3.5" 1.44MB floppy diskette.
4. The Microsoft Windows XP Home or Professional Edition (with Service Pack 2) OS CD.
5. The Device Drivers & Utilities + User’s Manual disc.
6. A second hard disk installed in the Primary HDD bay for RAID level 0 or 1 (required for RAID but not required 

for AHCI).
OR
A a second hard disk installed in the Primary HDD bay, and a third hard disk in the Secondary HDD bay for 
RAID level 5.
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SATA RAID or AHCI Setup Procedure (BIOS)
1. Go to the operable computer running Windows and insert a prepared formatted blank 3.5" 1.44MB floppy dis-

kette.
2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive of the operable computer.
3. Click Start (menu) > Run... and navigate (Browse..) to D:\Others\00Raiddriver\F6flpy32.exe and click OK.
4. Make sure the formatted blank 3.5" 1.44MB floppy diskette is inserted, and click OK.
5. A SATA RAID/AHCI driver diskette will now be created for you.
6. Remove the SATA RAID/AHCI driver diskette.
7. Start-up your computer and press <F2> to enter the BIOS.
8. Go to the Advanced menu, select "SATA Mode" and press Enter.

• For RAID Mode: - Set "SATA Mode" (“SATA Mode: (Advanced Menu)” on page 5 - 8) to "RAID".
                                   OR
• For AHCI Mode: - Set "SATA AHCI Enable" (“SATA Mode: (Advanced Menu)” on page 5 - 8) to 

"AHCI".

9. Press Esc and go to the Boot menu.
10. Set the external CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is inserted) as the first

device in the boot order from the Boot menu.
11. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press Enter to exit the BIOS and

reboot the computer.
12. For RAID mode see the instructions in “RAID Setup (Intel Matrix)” on page D - 33.
13. For AHCI mode see “Windows Setup for RAID & AHCI Modes” on page D - 35, and install the Intel Matrix

driver “Intel Matrix Driver Installation” on page D - 36.
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RAID Setup (Intel Matrix)
1. Press Ctrl + i to enter RAID configuration menu.

2. Select 1.Create RAID Volume and press Enter.
3. Type the RAID volume name and then press Tab or Enter to advance to the next field.
4. Specify (use the up and down arrow keys) the RAID level (RAID 0 or RAID 1 or RAID 5 - see Table D - 4, on 

page D - 30) and then press Tab or Enter to advance to the next field.
5. Press Enter and the system will select the physical disks to use.
6. Press Enter and select (if applicable) the Strip Size (best set to default).
7. Press Enter and select the Capacity size (best set to default).
8. Press Enter to Create Volume.
9. Confirm the selection by pressing Y.

1. Create RAID Volume
2. Delete RAID Volume
3. Reset Disks to Non-RAID
4. Exit

RAID Volumes:
None Defined

Physical Disks:
Port Drive Model Serial # Size Type/Status(Vol ID)
0 FUJITSU MHV2040B NW56T5C25FAF 93.2GB Non-RAID Disk
1 FUJITSU MHT2060B NR0UT52256W7 55.9GB Non-RAID Disk

Intel(R) Matrix Storage Manager option ROM v6.1.0.1002 ICH8R wRAID5
Copyright (C) 2003-06 Intel Corporation. All Rights Reserved.

[ MAIN MENU ]

[ DISK/VOLUME INFORMATION ]

[��]-Select [ESC]-Exit [ENTER]-Select Menu

Figure D - 20
Intel(R) Matrix Storage Manager
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10. This will now return to the main menu.

11. Select 4.Exit and press Enter, then press Y to exit the RAID configuration menu.
12. See over for Windows setup.

1. Create RAID Volume
2. Delete RAID Volume
3. Reset Disks to Non-RAID
4. Exit

RAID Volumes:
ID Name Level Strip Size Status Bootable
0 My RAID RAID1(Mirror) N/A 55.9GB Normal Yes

Physical Disks:
Port Drive Model Serial # Size Type/Status(Vol ID)
0 FUJITSU MHV2040B NW56T5C25FAF 93.2GB Member Disk(0)
1 FUJITSU MHT2060B NR0UT52256W7 55.9GB Member Disk(0)

Intel(R) Matrix Storage Manager option ROM v6.0.0.1022 ICH8R wRAID5
Copyright (C) 2003-06 Intel Corporation. All Rights Reserved.

[ MAIN MENU ]

[ DISK/VOLUME INFORMATION ]

[��]-Select [ESC]-Exit [ENTER]-Select Menu

Figure D - 21
RAID Created
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Windows Setup for RAID & AHCI Modes
13. Start the computer up, and press a key when you see the message "Press any key to boot from CD".
14. Press the F6 key when you see the message “Press F6 if you need to install third party SCSI or RAID 

driver”.
15. When the Windows Setup menu appears (Windows will load a number of files before the Setup menu appears), 

press the <S> key to "Specify Additional Device".
16. Insert the SATA RAID driver diskette into the external USB floppy drive, and press Enter.
17. Use the arrow keys to scroll down and select (see below):

• For RAID Mode - Intel(R) 82801HR/HH/H0 SATA RAID Controller (Desktop ICH8R)
• For AHCI Mode - Intel(R) 82801HR/HH/H0 SATA AHCI Controller (Desktop ICH8R)

18. After you have selected the appropriate option, press Enter.
19. The system will now read from the floppy disk drive and then return to the Windows Setup menu.
20. Press Enter to continue installing the operating system as normal (see your Windows documentation if you 

need help on installing the Windows OS).
21. Install the Windows drivers as per Table D - 3, on page D - 25, and then install the Intel Matrix driver (see 

overleaf).

Figure D - 22
SATA RAID Controller 

Desktop ICH8R

Intel(R) 82801HR/HH/H0 SATA RAID Controller (Desktop ICH8R)
Intel(R) 82801HR/HH/H0 SATA AHCI Controller (Desktop ICH8R)
Intel(R) 631xESB/632xESB SATA RAID Controller (Server/Workstation ESB2)
Intel(R) 631xESB/632xESB SATA AHCI Controller (Server/Workstation ESB2)
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Intel Matrix Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Optional.
3. Click 1.Install Intel Matrix > Yes.
4. Click Next > Next > Yes > Next 
5. Click Finish to restart the computer.
6. Run the Intel(R) Matrix Storage Manager application from the Start > Programs/All Programs menu.

Figure D - 23 - Intel Matrix Storage Console

7. The Intel(R) Matrix Storage Manager provides information on the RAID status.
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Intel WLAN Module
Before installing the Intel PRO/Wireless 3945ABG (802.11a/b/g) or Intel PRO/Wireless 4965AGN
(802.11a/g/n) WLAN driver use the Fn + F11 key combination to toggle power to the module.

Intel WLAN Driver Installation
1. Make sure the module is powered on (use the Fn + F11 key combination to toggle power to the mod-

ule), and then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Optional, and then click 2.Wireless Lan > Yes.
3. Click Install Software (button).
4. Click the button to accept the license and click Next > Next > OK.
5. Click OK to complete the installation.
6. You can configure the settings by going to the Intel (R) PROSet Wireless control panel (Start > Pro-

grams/All Programs > Intel PROSet Wireless), or by double-clicking the taskbar icon .
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User Guide

You can view the User
Guides from the Device
Drivers & Utilities + Us-
er’s Manual disc. 

Click Optional and then
click the Unlock button.
Click 2.Wireless Lan >
Yes.

Click View User Guide
(button).

Figure D - 24
Intel PROSet/

Wireless
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Bluetooth Module
Before installing the Bluetooth driver use the Fn + F12 key combination to toggle power to the module.

Bluetooth Driver Installation
1. Make sure the module is powered on and then insert the Device Drivers & Utilities + User’s Manual 

disc into the CD/DVD drive.
2. Click Optional, and then click 3.Bluetooth > Yes.
3. Choose the language you prefer, and click OK.
4. Click Next.
5. Click the button to accept the license agreement, and then click Next.
6. Click Next > Next > Install.
7. Click Finish.
8. The IVT Corporation BlueSoleil - Main Window screen will appear on the desktop.
9. You can configure the settings at any time by going to the IVT Corporation BlueSoleil - Main Win-

dow control panel (Start > Programs/All Programs > IVT BlueSoleil), or by clicking the taskbar 
icon .
Bluetooth Module D - 39



Windows XP Information

D

User Guide

View the BlueSoleil User
Guides (Contents and In-
dex) from the Help menu
(or press the F1 key) in
the IVT Corporation
BlueSoleil - Main Win-
dow control panel. Click
BlueSoleil User Guides
in the Contents tab, and
click to select the appro-
priate User Guide from
the panel on the right.

Figure D - 25
Bluetooth Control 

Panel & User Guides
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Bluetooth Local Area Connection Icon
If you want to display the Local Area Connection icon for the Bluetooth connection
in the taskbar, set it up as follows:

1. Access the Network Connections control panel in Windows (Start > Settings > Net-
work Connections OR Start > Connect To > Show all Connections) or by clicking the 
taskbar icon .

2. Right-click the Bluetooth connection icon, and select Properties.
3. Click to put a tick in the “Show icon in the notification area when connected” box.
4. Close the control panels and the icon  for the Bluetooth connection will be displayed 

in the taskbar when connected (see sidebar and overleaf).

Disconnecting

In order to have the taskbar
icon display the correct
connection status, you will
need to exit the IVT Corpo-
ration BlueSoleil - Main
Window by clicking the File
menu and selecting Exit
(see over).

After exiting the program
you can then use the Fn +
F12 key combination to turn
off the Bluetooth module.

If you use the close button,
or turn off the Bluetooth
module (by using the Fn +
F12) the taskbar icon will
not display the correct sta-
tus 

Figure D - 26
Local Area 
Connection
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5. Use the Fn + F12 key combination to turn on the Bluetooth module.
6. Run the IVT Corporation BlueSoleil program from the desktop icon or Start menu.
7. The connection status will then be displayed.

Figure D - 27 - Bluetooth Connected
8. To disconnect click File from the IVT Corporation BlueSoleil - Main Window, and select Exit (the Local Area

Connection will then display “A network cable is unplugged”).
9. Do not use the close  button or Fn + F12 key combination before clicking File > Exit or the correct status will

not be displayed.
10. You can then use the Fn + F12 key combination to turn off the Bluetooth module (check the LED icon for the

Bluetooth module power status).

Figure D - 28 - Bluetooth Disconnected
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PC Camera Module
If you have included the PC Camera module in your purchase option, you will have
the appropriate application provided on the Device Drivers & Utilities + User’s
Manual disc. There are 1.3M or 2.0M pixel camera options available for this com-
puter, depending on your purchase configuration. The BisonCap or Video View ap-
plications (one will be available depending on your camera module) can be used to
capture video files.

Before installing the PC Camera driver use the Fn + F10 key combination to toggle
power to the module. 

Taking Still Pictures

Double-click the My
Computer icon on the
desktop, or go the Start
menu and point to My
Computer, then click it.

.Double-click the camera
icon. 

Click Take a new picture
in the Camera Tasks
box.
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PC Camera Driver Installation
1. Make sure the module is powered on and then insert the Device Drivers & Utilities + User’s Manual 

disc into the CD/DVD drive.
2. Click Optional, and then click 4.PC Camera, Web cam > Yes.

For the BisonCap Application:
3. Choose the language you prefer and click Next > Next.
4. Click Finish to restart the computer.
5. Run the BisonCap application program from the BisonCam shortcut on the desktop, or from the 

BisonCam item in the Start > Programs/All Programs menu (if the hardware is turned off use the Fn 
+ F10 key combination to turn it on again).

For the Video View Application:
1. Click Install.
2. Click to select Yes or No in answer to the power system question.
3. Click Finish > Finish to restart the computer.
4. Run the Video View application program from the Video View shortcut on the desktop, or from the 

USB2.0 PC Camera item in the Start > Programs/All Programs menu (if the hardware is turned off 
use the Fn + F10 key combination to turn it on again).
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in
Windows (see Figure D - 29 on page D - 46).

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-
click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).

2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio input from the Mixer device menu.
5. Click Mic Volume (check box) if it is not checked, then click OK.
6. Boost the Recording volume in the Recording Control panel as high as it will go.
7. Close the control panels.
8. Run the BisonCap/Video View application program from the Start > Programs/All Programs > BisonCam/

USB2.0 PC Camera menu.
9. Go to the Devices menu heading and select Realtek HD Audio input (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
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Figure D - 29
Audio Setup for 

PC Camera
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BisonCap
BisonCap is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.

1. Run the BisonCap application from the Start > Programs/All Programs > BisonCam 
menu (it is recommended that you set the capture file before the capture process - see 
Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page D - 45) and select Start Capture.

3. On the first run of the program (if you have not set the captured file) you will be asked to 
choose a file name and size (see the sidebar - Pre-Allocating File Space) for the 
captured file. Click Start Capture again.

4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., 

choose a file name and location, and then click Open (you can view the file using the 
Windows Media Player).

Set Capture File
In the BisonCap application you will only be asked to set the capture file name on
the first run of the program. When you run the program the next time the file will au-
tomatically be overwritten with the newly captured file. To avoid overwriting files
you can go to the Set Capture File.. option in the File menu, and set the file name
and location before capture. Set the name and location then click Open (you can
choose Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate the
file size for the capture file
in the BisonCap applica-
tion. You can choose to
ignore this by clicking
Cancel.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

You may find it helpful to
defragment the HDD be-
fore capture.
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Eliminating Screen Flicker (BisonCap) 
If you find that the video screen in the BisonCap application is flickering, you can
try to adjust the setting in the Video Capture Filter options.

1.Run the BisonCap program.
2.Go to Options and scroll down to select “Video Capture Filter...”.
3.Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure D - 30
Video Capture Filter
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Video View
Video View is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.

1. Run the Video View program from the Start > Programs/All Programs > USB2.0 PC 
Camera menu (it is recommended that you set the capture file before the capture pro-
cess - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page D - 45) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the 
video, and press Esc to stop the capture.

Set Capture File
Prior to capturing video files you may Set Capture File... To avoid overwriting files
you can go to the Set Capture File.. option in the File menu, and set the file name
and location before capture. Set the name and location then click Open (you can
choose Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate
the file size for the cap-
ture file in the Video
View program.

Pre-allocating space on
the hard disk can im-
prove the capture quali-
ty (particularly of large
capture files), by reduc-
ing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.
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Eliminating Screen Flicker (Video View)
If you find that the video screen in the Video View program is flickering, you can try
to adjust the setting in the Video Capture Filter options.

1. Run the Video View program.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Flickering Reduction in Image (tab).

Figure D - 31
Video Capture Filter
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Zoom (Video View)
If you have enabled digital zoom when installing the Video View camera driver you
may use the Options > Setting menu to zoom the camera in and out.

1. Run the Video View program.
2. Go to Options and scroll down to select Setting.
3. Use the slider to adjust the zoom level, and click OK to save the setting.

Still Image Capture (Video View)
You can capture still images by using the Snapshot command from the Capture
menu.

1. Run the Video View program.
2. Go to Capture and select Snapshot.
3. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Figure D - 32
Setting

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

Figure D - 33
Snapshot Folder
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Mini-PCI TV Tuner Module
The Mini-PCI TV Tuner Module driver and application (for MPC788/MPC718) are provided on a separate CD-
ROM for Windows XP (see “Mini-PCI TV Tuner Module” on page 7 - 25 for further information).

MPC788/MPC718 Driver & Cyberlink PowerCinema Installation
1. Insert the driver MPC788 or MPC718 disc into the CD/DVD drive.
2. Click XP Setup.
3. Choose the Setup Language you prefer, and then click Next.
4. Click Next > Next.
5. Click the button to accept the license agreement for Microsoft(R) DirectX(R), and then click Next > 

Next > Finish.
6. Choose the Setup Language you prefer for PowerCinema, and then click OK.
7. Click Next > Yes.
8. Type in the Cyberlink PowerCinema CD Key provided (make sure you also input a User and Com-

pany Name), and then click Next.
9. Click Next > Next > Next > Finish.
10. Click Next > Install > Finish to install SimHID.
11. Click Finish to restart the computer.
12. Run the application from the Start > Programs/All Programs > Cyberlink PowerCinema and select 

the PowerCinema program, or double-click the icon on the desktop.
13. Help is available from within the PowerCinema program.
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